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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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Copyright
Copyright © 2006 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Amendment Record Sheet

Amendment No Date Inserted By Comments

Issue 1 06/2006 ET
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Battery endurance

Battery Capacity (mAh) Talk time Stand-by

BP-5L 1500 up to 6 hrs up to 12 days

Charging times

ACP-4

2 h 10 min

Environmental conditions

Environmental condition Ambient temperature Notes

Normal operation -15oC...+55oC Specifications fulfilled

Reduced performance -25oC...-15oC

+55oC...+70oC

Operational for shorts periods
only

Intermittent operation -40oC...-15oC

+70oC...+85 oC

Operation not guaranteed but an
attempt to operate does not
damage the phone.

No operation or storage <-40oC...>+85oC No storage or operation: an
attempt may damage the phone.

Charging allowed -25oC...+50oC

Long term storage conditions 0oC...+85oC

DC characteristics

Signal Min Nom Max Note

VBAT 3.1V 3.7V 4.2V (charging
high limit voltage

3.1V SW cut off
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Enhancement Type

Advanced Car Kit CK-7W

Mobile Charger DC-4

 Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T) Weight (g) Volume (cm3)

Transceiver with BP-5L
1500mAh li-ion battery
back

117.1 x 69.7 x 17.8 / 13.3
mm

144 (including BP-5L
battery)

103.4

Main RF characteristics for GSM850/900/1800/1900 phones

Parameter Unit

Cellular system GSM850, EGSM900 and GSM1800/1900

Rx frequency band GSM850: 869-894 MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

Tx frequency band GSM850: 824-849 MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

Output power GSM850: +5 ... + 33 dBm/3.2mW .. 2W

GSM900: +5...+31.2dBm / 3.2mW.. 1.3 W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: 0...30.9dBm/1.0mW... 1.26W

Number of RF channels GSM850: 123

GSM900: 173

GSM1800: 373

GSM1900: 298

Channel spacing 200 kHz

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16
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Enhancement Type

Wireless Boom Headset HS-4W

Wireless Headset HDW-3

Wireless Headset HS-26W

Wireless Headset HS-11W

Wireless Clip-on Headset HS-21W

Wireless Headset HS-36W

Wireless Headset HS-58W

Table 2 Data

Enhancement Type

Connectivity cable DKE-2

Mini SD card 128 MB MU-17

Mini SD card 256 MB MU-18

Mini SD card 512 MB MU-23

Mini SD card 1GB MU-24

Table 3 Power

Enhancement Type

Battery BP-5L

Nokia Compact Charger AC-3U

Nokia Travel Charger AC-4U

Charger Adapter CA-44

Table 4 Messaging

Enhancement Type

Wireless Keyboard upgrade SU-8W

Table 5 Positioning

Enhancement Type

Wireless GPS Module update LD-1W

Table 6 Car

Enhancement Type

Wireless Plug-in Car Handsfree HF-6W
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Productivity
• SMS, MMS and email

• MS Word, PowerPoint , Excel and Adobe PDF viewers

• PIM (Calendar & Contacts)

• Internet browser

• Video streaming (3GPP)

• Logs (last calls , timers and history list)

• Instant messaging

• JavaTM MIDP 2.0, CLDC 1.13D API, PIM API, File access API

• MP3

• Data Transfer

• Settings Wizard/Access Point Configurator

Sales package
• Transceiver RM-88

• BP-5L Li-ion Battery Cell

• AC-4U Charger

• User Guide

• CD-ROM

• Headset HS-40

• USB Cable DKE-2

• Quick Start Guide

 Product and module list

Module name Type code Notes

System/RF Module 1QR Main PWB with components

EL-Dome sheet

Chassis Assy

Display Module

Keyboard

A-cover Assy

SW Module

 Mobile enhancements

Table 1 Audio

Enhancement Type

Mono Headset HS-40

Basic Stereo Headset HS-47
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 RM-88 product selection
RM-88 is a GSM handportable phone, supporting the EGSM 850/900/1800/1900 bands.

The MMS implementation follows the OMA MMS standard release 1.2.

WAP 2.0 compatible browser supports XHTML Mobile Profile (MP) and uses a TCP/IP stack to communicate
with a gateway in network.

RM-88 uses Symbian 9.1a operating system and supports also MIDP Java 2.0 & CLDC1.1, providing a good
platform for 3rd party applications.

Figure 1 View of RM-88

 RM-88 product features and sales package

Bearers & transport
• GSM Quadband World Phone E850/900/1800/1900 EGPRS (class B, Multislot class 11)

Software platform
• SW platform: Nokia Series 60 rel 3.0

Connectivity
• Bluetooth (Headset & Handsfree profiles, BIP, GOP)

• Mini SD Card

• Mini-USB interface

• PC Suite connectivity with USB & Bluetooth
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 Exploded view

Exploded view

Figure 2 Exploded view of RM-88
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 Parts lists

Mechanical spare parts list

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS).

To ensure you are always using the latest codes, please check the PWS on a daily basis.

Bold = ASSY

"XXXXXXX" = VARIANTS

"-" = NOT AVAILABLE

"???????" = AVAILABLE AS SPARE PART

I0xx = ITEM codes for upper or mono block

I1xx = ITEM codes for hinge block

I2xx = ITEM codes for lower block

I3xx = ITEM codes for soldered spare parts on the upper, hinge or lower block and not exchangable

ITEM/
CIRCUIT

REF.

PART NO PART NAME QTY

I009 ??????? Window Assembly 040-012649 1

A1 ??????? A-Cover Assembly Silver 040-012429 1

I026 ??????? SCREW M1.6X5.7 DMD12402 TORX SILV 6

I008 ??????? SCREW M1.4X3.4 TORX PLUS 4IP 1

I007 ??????? Remform screw 1.8x8 1

I019 ??????? Battery Release Spring 1

I028 ??????? BLANK LABEL 29mmx18mm EXP65673 1

I021 ??????? Joystick Button 040-012658 1

I018 ??????? Battery Release Button 040-012946 1

I023 ??????? Joystick module tape 040-020164 1

I005 XXXXXXX Operator Logo painted Silver
040-012438

1

I027 XXXXXXX Antenna Lid, painted Silver 040-012654 1

I029 ??????? Battery Cover painted 040-012428 Silver 1

I012 ??????? EL-Dome Sheet 040-012655 1

I006 XXXXXXX KEYMAT PRINTED SILVER 040-021863 EN-
NL

1

I020 ??????? 1RE JOYSTICK ASSEMBLY 1

A2 ??????? Chassis Assembly 040-012635 1

I017 ??????? CONNECTOR HOUSING ASSEMBLY
040-015883

1

I022 ??????? Side Button Module 040-012642 1

I011 ??????? LCD AM 320x240 COG 16MCo Oxford 1
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ITEM/
CIRCUIT

REF.

PART NO PART NAME QTY

I016 ??????? MIC MOD+HOLDER TOMAHAWK -42+-3DB 1

I010 ??????? EARPIECE+SPRING 22+/-3DB 32R 7X11 1

I015 ??????? CONN CHR DIA 2.0MM COMPRESS 1

A3 ??????? ANTENNA MOD GSM/WCDMA P2524 1

RM-88 component parts list

Component parts list (1qr_10a_asmmtx)

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS).

To ensure you are always using the latest codes, please check the PWS on a daily basis.

Item Side Grid reference Description and value

A2400 Bottom C 8
SHIELD_040
_015795

PWB POWER
SHIELD CAN ~ ~

A2801 Bottom C 13
SHIELD_PWB
_CAN_RAP

SHIELD PWB
CAN RAP ~ ~

A4801 Bottom K 10
SHIELD_040
_017960

PWB CAN
COMBO ~ ~

A4802 Bottom L 7
SHIELD_PWB
_CAN_APE

SHIELD PWB
CAN APE ~ ~

A6001 Bottom L 4

SHIELD_PWB
_CAN_WCDM
A

SHIELD PWB
CAN WCDMA ~ ~

A7506 Bottom G 16
SHIELD_PWB
_CAN_PA

SHIELD PWB
CAN Pa ~ ~

A7507 Bottom G 13
SHIELD_PWB
_CAN_PIHI

SHIELD PWB
CAN PIHI ~ ~

B2200 Bottom C 10
CRYSTAL_3.3
X1.6_H0.9

CRYSTAL
32.768KHZ
+-30PPM
12.5PF 32.768kHz ~

C2000 Bottom D 5 0402C
Chipcap 5%
NP0 27p 50V

C2001 Bottom D 5
0603C_H0.9
5

CHIPCAP X5R
1U K 25V 0603 1u0 25V

C2002 Bottom E 4 0603C

CHIPCAP X5R
2U2 K 6V3
0603 2u2 6V3

C2003 Bottom E 4 0402C

CHIPCAP X7R
33N K 10V
0402 33n 10V
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Item Side Grid reference Description and value

C2004 Bottom E 4 0402C

CHIPCAP X7R
33N K 10V
0402 33n 10V

C2006 Bottom E 3 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C2025 Bottom F 4 0805C

CHIPCAP X5R
10U M 6V3
0805 10U 6V3

C2026 Bottom F 4 0805C

CHIPCAP X5R
10U M 6V3
0805 10U 6V3

C2027 Bottom F 3 0402C
Chipcap 5%
X7R 3n3 50V

C2028 Bottom F 3 0402C
Chipcap 5%
NP0 47p 50V

C2029 Bottom F 3 0402C
Chipcap 5%
X7R 3n3 50V

C2030 Bottom H 3 0402C
Chipcap 5%
X7R 270p 50V

C2031 Bottom F 3 0402C
Chipcap 5%
NP0 47p 50V

C2071 Bottom K 18
TANT_C_6.2
X3.4_H1.7

CHIPTCAP
150U M 10V
6X3.2X1.5 150u_10V 10V

C2100 Bottom G 3 0402C

CHIPCAP X7R
33N K 10V
0402 33n 10V

C2101 Bottom G 3 0402C

CHIPCAP X7R
33N K 10V
0402 33n 10V

C2102 Bottom G 3 0603C

CHIPCAP X5R
2U2 K 6V3
0603 2u2 6V3

C2103 Top F 22 0402C
Chipcap 5%
X7R 1n0 50V

C2104 Top F 22 0402C
Chipcap 5%
X7R 1n0 50V

C2200 Bottom B 9 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2201 Bottom D 9 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2202 Bottom E 10 0402C
Chipcap X7R
10% 50V 0402 1n0 50V
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Item Side Grid reference Description and value

C2203 Bottom C 10 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2204 Bottom C 10 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2205 Bottom B 10 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2206 Bottom C 10 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2207 Bottom D 10 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2208 Bottom C 10 0402C
Chipcap 5%
NP0 27p 50V

C2209 Bottom C 10 0402C
Chipcap 5%
NP0 22p 50V

C2210 Bottom D 7 0603C
CHIPCAP X5R
1U K 16V 0603 1u0 16V

C2211 Bottom D 7 0603C

CHIPCAP X5R
4U7 K 6V3
0603 4u7 6.3V

C2212 Bottom C 7 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2213 Bottom D 9 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2214 Bottom D 9 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2215 Bottom E 8 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2216 Bottom E 8 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2217 Bottom D 10 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2218 Bottom C 9 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2219 Bottom D 10 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2220 Bottom C 8 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C2221 Bottom E 7 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2222 Bottom D 7 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V
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Item Side Grid reference Description and value

C2223 Bottom B 8 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C2224 Bottom B 9 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C2225 Bottom D 9 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2226 Bottom D 8 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2227 Bottom C 7 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2228 Bottom D 8 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2229 Bottom C 7 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2230 Bottom D 9 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2231 Bottom B 8 0805C

CHIPCAP X5R
10U M 6V3
0805 10U 6V3

C2232 Bottom D 8 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2270 Bottom B 8 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2271 Bottom B 8 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2272 Bottom B 9 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2273 Bottom C 7 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2274 Bottom C 7 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2275 Bottom B 7 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C2281 Bottom E 8 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2300 Bottom C 6 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C2301 Bottom B 6 0805C

CHIPCAP X5R
22U M 6V3
0805 22u 6V3
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Item Side Grid reference Description and value

C2302 Bottom B 7 0805C

CHIPCAP X5R
22U M 6V3
0805 22u 6V3

C2303 Bottom D 5 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2304 Bottom C 7 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C2305 Bottom E 5 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2306 Bottom C 5 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2307 Bottom C 5 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2309 Bottom B 5 0805C

CHIPCAP X5R
22U M 6V3
0805 22u 6V3

C2312 Bottom C 5 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2313 Bottom D 5 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2314 Bottom D 6 0603C

CHIPCAP X5R
4U7 K 6V3
0603 4u7 6.3V

C2315 Bottom E 7
0603C_H0.9
5

CHIPCAP X5R
1U K 25V 0603 1u0 25V

C2316 Bottom E 7 0402C
Chipcap 5%
NP0 56p 50V

C2317 Bottom D 7 0402C
Chipcap 5%
NP0 27p 50V

C2319 Bottom E 7
0603C_H0.9
5

CHIPCAP X5R
1U K 25V 0603 1u0 25V

C2700 Bottom D 16 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2800 Bottom I 11 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2801 Bottom L 10 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2802 Bottom I 10 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V
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Item Side Grid reference Description and value

C2803 Bottom I 10 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2804 Bottom I 12 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2805 Bottom L 9 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2807 Bottom L 10 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C2808 Bottom I 11 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2809 Bottom I 11 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2810 Bottom I 9 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2811 Bottom L 9 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2812 Bottom I 10 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2813 Bottom L 12 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2814 Bottom I 11 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2815 Bottom K 12 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2818 Bottom J 12 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2819 Bottom L 12 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C2820 Bottom I 9 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V
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Item Side Grid reference Description and value

C2830 Bottom L 11 0402C
Chipcap X7R
10% 50V 0402 1n0 50V

C3000 Bottom K 8 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3001 Bottom J 7 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C3002 Bottom J 7 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3003 Bottom J 7 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C3004 Bottom J 6 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3005 Bottom M 7 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3006 Bottom L 8 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3007 Bottom M 6 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C3008 Bottom J 7 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3009 Bottom M 7 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3010 Bottom J 12 0402C
Chipcap
+-0.25pF NP0 3p3 50V

C3011 Bottom J 6 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3017 Bottom L 8 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3018 Bottom M 6 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C3100 Bottom G 6 0402C
CHIPCAP NP0
27P J 50V 0402 27p0 50V
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Item Side Grid reference Description and value

C4400 Top C 22 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C4401 Top C 22 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C4402 Top C 22 0402C
Chipcap 5%
NP0 27p 50V

C4403 Top C 22 0402C
Chipcap 5%
NP0 27p 50V

C4404 Bottom I 4 0402C
Chipcap 5%
NP0 68p 50V

C4405 Bottom I 4 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C4408 Bottom H 2 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C4409 Bottom I 2 0603C

CHIPCAP X5R
4U7 K 6V3
0603 4u7 6.3V

C4410 Bottom H 2 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C4411 Bottom I 2 0402C
Chipcap 5%
NP0 27p 50V

C4414 Bottom I 5 0603C
CHIPCAP X5R
1U K 16V 0603 1u0 16V

C4420 Bottom B 13 0402C
Chipcap X7R
5% 16V 0402 10n 16V

C4421 Bottom B 13 0402C
Chipcap X7R
5% 16V 0402 10n 16V

C4424 Bottom I 5 0402C
CHIPCAP X5R
1U K 6V3 0402 1u0 6.3V

C5200 Bottom L 12 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C5201 Bottom M 11 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C5202 Bottom L 11 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C5203 Bottom M 11 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V
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Item Side Grid reference Description and value

C5204 Bottom L 11 0402C_H0.6

CHIPCAP X5R
100N M 16V
0402 100n 16V

C6031 Bottom K 3 0402C
Chipcap 5%
NP0 18p 50V

C6032 Bottom L 3 0402C
Chipcap 5%
NP0 100p 50V

C6033 Bottom L 3 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C6034 Bottom L 3 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C6035 Bottom L 4 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C6036 Bottom L 3 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C6037 Bottom L 4 0402C
CHIPCAP X5R
1U5 K 4V 0402 1u5 4V

C6038 Bottom K 4 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C6039 Bottom J 4 0402C
Chipcap 5%
NP0 18p 50V

C6041 Bottom K 3 0402C
Chipcap
+-0.25pF NP0 2p7 50V

C6042 Bottom K 4 0402C
Chipcap
+-0.25pF NP0 2p7 50V

C6050 Bottom K 3 0402C
CHIPCAP X5R
1U K 6V3 0402 1u0 6.3V

C7501 Bottom H 13 0402C
Chipcap
+-0.25pF NP0 2p7 50V

C7503 Bottom F 12 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C7504 Bottom H 13 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C7505 Bottom F 12 0402C
CHIPCAP X5R
1U K 6V3 0402 1u0 6.3V

C7506 Bottom F 12 0603C
CHIPCAP X5R
1U K 6V3 0603 1u0 6.3V

C7507 Bottom F 12 0402C
Chipcap X7R
5% 16V 0402 10n 16V

C7508 Bottom F 13 0402C
Chipcap 5%
NP0 18p 50V
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Item Side Grid reference Description and value

C7509 Bottom F 12 0402C
Chipcap
+-0.25pF NP0 2p7 50V

C7510 Bottom F 13 0402C
Chipcap 5%
NP0 27p 50V

C7511 Bottom G 12 0603C

CHIPCAP NP0
2N2 G 16V
0603 2n2 16V

C7512 Bottom G 11 0402C
Chipcap
+-0.25pF NP0 2p7 50V

C7513 Bottom F 12 0402C
Chipcap X7R
10% 16V 0402 10n 16V

C7515 Bottom H 12 0402C
Chipcap
+-0.25pF NP0 3p3 50V

C7516 Bottom G 12 0402C
Chipcap 5%
X7R 470p 50V

C7517 Bottom G 12 0402C
Chipcap
+-0.25pF NP0 3p3 50V

C7518 Bottom F 13 0402C

CHIPCAP X5R
100N K 10V
0402 100n 10V

C7520 Bottom H 16 0402C
Chipcap
+-0.25pF NP0 3p3 50V

C7522 Bottom F 16 0402C
Chipcap
+-0.25pF NP0 1p8 50V

C7523 Bottom H 16 0402C
CHIPCAP X5R
1U K 6V3 0402 1u0 6.3V

C7524 Bottom F 15 0402C
CHIPCAP X5R
1U K 6V3 0402 1u0 6.3V

C7525 Bottom F 17 0402C
Chipcap 5%
NP0 18p 50V

C7530 Bottom M 4 0402C
Chipcap X7R
10% 25V 0402 4n7 25V

C7590 Bottom L 3 0402C
Chipcap X7R
5% 16V 0402 10n 16V

C7591 Top K 22 0402C
Chipcap 5%
NP0 100p 50V

C7593 Top J 22 0402C
Chipcap
+-0.25pF NP0 8p2 50V

C7594 Top J 23 0402C
Chipcap 5%
NP0 12p 50V

C7595 Top J 22 0402C
Chipcap 5%
NP0 12p 50V
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Item Side Grid reference Description and value

C7596 Top K 23 0402C
Chipcap 5%
NP0 100p 50V

C7597 Bottom M 3 0402C
Chipcap 5%
NP0 100p 50V

D2200 Bottom C 8 TFBGA_108

RETU 3.02
TSA1GJWE
TFBGA108 ~ ~

D2800 Bottom K 10 uBGA_289
RAPGSM V1.1
PA uBGA289 ~ ~

D3000 Bottom L 7
FBGA133_11
.6X13.1

COMBO
256MNOR
+1GM3
+256MDDRSDR
AM FBGA133

8Mx16/16M
x16/8Mx16 ~

D4400 Bottom C 13 LLP_44

MCU E 8BIT
COP8TAB5HYQ
8 LLP44 ~ ~

F2000 Bottom C 4
0603_FUSE_
AVX2MATS

SM FUSE F 2.0A
32V 2A ~

G2200 Bottom B 12
BATTER_EEC
EP

RTC BACUP
CAPAC 311 SIZE
FOR 2.6V 4UAH 2.6V ~

G7500 Bottom H 12
VCO_DCS027
33

VCO
3296-3980MH
Z 4-BAND
MATSUSHITA

3296-3980
MHz ~

G7501 Bottom F 11
NKG3176B_
H1.0

VCTCXO
38.4MHZ 2.5V 38.4MHz ~

L2000 Bottom D 4 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~

L2100 Top F 23
0405_2_MAT
SU

CHIP BEAD
ARRAY
2X1000R 0405

2x1000R/
100MHz ~

L2102 Bottom B 20
COIL_0603C
S

CHIP COIL 56N J
Q38/250MHZ
0603 56nH ~

L2103 Bottom B 20
COIL_0603C
S

CHIP COIL 56N J
Q38/250MHZ
0603 56nH ~

L2202 Bottom E 9 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~
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L2203 Bottom E 9
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L2204 Bottom E 9
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L2205 Bottom E 9 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~

L2206 Bottom E 8
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L2270 Bottom B 8 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~

L2271 Bottom B 8 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~

L2272 Bottom C 8 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~

L2273 Bottom B 8 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~

L2301 Bottom B 5 0603_BLM

FERR.BEAD
220R/100M 2A
0R05 0603

220R/
100MHz ~

L2302 Bottom B 6
CHOKE_SER4
00_H1.2

INDUCT WW
10UH 0A65
0R35 4X4X1.2 10uH ~

L2304 Bottom D 6
CHOKE_SER3
00

CHOKE 22U M
1R5 0.35A 22uH ~

L2305 Bottom D 5
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L2306 Bottom C 5
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L4400 Top C 22
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L4401 Top C 22
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~
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L4402 Bottom I 5
CHOKE_ELT3
KN152C

COIL 0.47MH
50MA
3.3X3.4X1.4M
M 0.47MH ~

L5200 Bottom L 12
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L6030 Bottom K 3 0402L

CHIP COIL 2N7
+-0N3
Q29/800M
0402 2n7H ~

L6031 Bottom K 4 0402L

CHIP COIL 2N7
+-0N3
Q29/800M
0402 2n7H ~

L6032 Bottom K 4 0402L

CHIP COIL 22N J
Q28/800M
0402 22nH ~

L7500 Bottom G 14 0402L

CHIP COIL 18N J
Q29/800M
0402 18nH ~

L7501 Bottom G 14 0402L

CHIP COIL 33N J
Q23/800M
0402 33nH ~

L7502 Bottom F 13
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

L7503 Bottom F 16 0402LQW

CHIP COIL 27N
C Q25/250MHZ
0402 27nH ~

L7504 Bottom G 14 0402L

CHIP COIL 47N J
Q23/800M
0402 47nH ~

L7505 Bottom G 14 0402L

CHIP COIL 22N J
Q28/800M
0402 22nH ~

L7515 Bottom H 12
0402L_H0.4
5

CHIP COIL 4N7
+-0N1
Q29/1GHZ
0402 4n7H ~

L7530 Bottom H 14 0402L

FERR.BEAD
240R7100M
0.4A 0R4 0402

240R/
100MHz ~
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L7531 Bottom F 14 0402L

FERR.BEAD
240R7100M
0.4A 0R4 0402

240R/
100MHz ~

L7591 Top J 22 0402L

CHIP COIL 6N8 J
Q27/800M
0402 6n8H ~

L7592 Top K 23 0402L_POL2

CHIP COIL 82N
+-0N3
Q17/300M
0402 82nH ~

M2100 Bottom C 4
VIBRA_M_KH
N4NX1RA

SMD VIBRA
MOTOR 1.3V
90MA
9000RPM ~ ~

N2300 Bottom C 6
TFBGA_84_6
.15X6.15

TAHVO V5.2 LF
TFBGA84 ~ ~

N2301 Bottom E 6
USMD8_1.69
X1.69

WHITE LED
DRIVER 4LEDS
500MW
8BUMP USMD8 ~ ~

N4401 Bottom H 2
IRDA_RPM9
60

IRDA
1.15MBPS
2.2MM ROHS ~ ~

N4402 Bottom H 4 MSOP_10

EL DRIVER
D381B 2-7V
MSOP-10 ~ ~

N4403 Bottom E 13 SC70_5

1XOP AMP
2.7-5.5V
LMV321
SC70-5 ~ ~

N5200 Bottom M 11
USMD16_2.0
3X2.03

VREG & LEVEL
SHIFT LP3928
USMD16 ~ 2.8V

N6030 Bottom L 4
CSP_47_3.85
X4.05

BC4-
ROM1.0RDL ~ ~

N7505 Bottom G 13 TFBGA144

AHNE301A
TRANCEIVER
RFIC TFBGA144 ~ ~

N7520 Bottom G 16 RF9282E3.6

PA RF9282E6.3
GSM/EDGE
850/900/1800
/1900 ~ ~

N7590 Top J 22 SC70_6_FAIR

HIGH POWER
SPDT RF SW
SC70 ~ ~
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R2000 Bottom E 4 0402R
Resistor 5%
63mW 220R ~

R2001 Bottom E 4
FLIP_CHIP_8
_1.7X1.7

ASIP SINGLE
ENDED
MICROPHONE
INTERF BGA8 ~ ~

R2003 Bottom G 4 0402R

Chipres 0W06
22k F 200ppm
0402 22k ~

R2004 Bottom G 4 0402R

Chipres 0W06
22k F 200ppm
0402 22k ~

R2006 Bottom F 3 BGA11

ASIP 4 LINES
AUDIO FILTER
BGA11 ~ ~

R2007 Bottom I 3
uBGA11_1.6
X2.15

ASIP SILIC USB
OTG / ESD
BGA11 ~ ~

R2008 Bottom I 3 0404_RP

RES NETWORK
0W06 220K/
120K J 0404 220k/120k ~

R2015 Bottom D 4
BGA4_1.01X
1.07 ASIP TVS BGA4 ~ ~

R2025 Bottom F 4 0402R
Resistor 5%
63mW 10R ~

R2026 Bottom F 4 0402R
Resistor 5%
63mW 10R ~

R2030 Bottom I 3 0402R
Resistor 5%
63mW 100R ~

R2070 Bottom K 18 0402_VAR

CHIP VARISTOR
VWM14V
VC50V 0402 14V/50V ~

R2071 Bottom C 10 0402_NTH5

NTC RES 47K J
B=4050+-3%
0402 47k ~

R2100 Bottom G 3
FLIP_CHIP_8
_1.7X1.7

ASIP SINGLE
ENDED
MICROPHONE
INTERF BGA8 ~ ~

R2101 Bottom G 3 0402R
Resistor 5%
63mW 220R ~

R2104 Top F 23 0402_VAR

CHIP VARISTOR
VWM14V
VC50V 0402 14V/50V ~
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R2105 Top F 23 0402_VAR

CHIP VARISTOR
VWM14V
VC50V 0402 14V/50V ~

R2106 Bottom C 17 0402_VAR

CHIP VARISTOR
VWM14V
VC50V 0402 14V/50V ~

R2107 Bottom C 17 0402_VAR

CHIP VARISTOR
VWM14V
VC50V 0402 14V/50V ~

R2108 Top F 22 0402R
Chipres 0W06
jumper 0402 0R ~

R2109 Top F 22 0402R
Chipres 0W06
jumper 0402 0R ~

R2200 Bottom E 10 0402R
Resistor 5%
63mW 100k ~

R2201 Bottom D 10 0402R
Resistor 5%
63mW 120k ~

R2206 Bottom B 9 0402R
Resistor 5%
63mW 1k0 ~

R2207 Bottom B 10 0402R
Resistor 5%
63mW 1k0 ~

R2208 Bottom B 10 0402R
Resistor 5%
63mW 1k0 ~

R2209 Bottom B 10 0402R
Resistor 5%
63mW 1k0 ~

R2212 Bottom B 9 0402R
Resistor 5%
63mW 470R ~

R2213 Bottom D 10 0402R
Resistor 5%
63mW 4k7 ~

R2214 Bottom E 10 0402R
Resistor 5%
63mW 4k7 ~

R2216 Bottom D 10 0402R
CHIPRES 0W06
2M2 J 0402 2M2 ~

R2307 Bottom C 5 0402R
Resistor 5%
63mW 100R ~

R2310 Bottom D 7 0402R
Resistor 5%
63mW 33R ~

R2700 Bottom D 16
uBGA8_1.47
X1.47

ASIP SIM
INTERFACE
**LOW
CAP**BGA8 ~ ~
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R3000 Bottom K 8 0402R
Resistor 5%
63mW 4k7 ~

R3002 Bottom I 10 0402R
Resistor 5%
63mW 10R ~

R3003 Bottom K 8 0402R
Resistor 5%
63mW 4k7 ~

R3004 Bottom K 8 0402R
Resistor 5%
63mW 4k7 ~

R3007 Bottom M 8 0402R
Resistor 5%
63mW 10k ~

R3008 Bottom L 8 0402R
CHIPRES 0W06
20R J 0402 20R ~

R4400 Top B 22 0402R
Resistor 5%
63mW 470k ~

R4401 Top B 22 0402R
Resistor 5%
63mW 100k ~

R4402 Top B 22 0402R
Resistor 5%
63mW 470k ~

R4403 Top A 22 0402_NTH5

NTC RES 47K J
B=4050+-3%
0402 47k ~

R4404 Bottom I 5 0402R
Chipres 0W06
jumper 0402 0R ~

R4406 Top L 22 0402_VAR

CHIP VARISTOR
VWM14V
VC50V 0402 14V/50V ~

R4407 Bottom D 13 0402R
Resistor 5%
63mW 18R ~

R4409 Bottom D 13 0402R
Resistor 5%
63mW 18R ~

R4410 Bottom D 14 0402R
Resistor 5%
63mW 1k0 ~

R4412 Top B 22 0402R
Resistor 5%
63mW 680R ~

R4413 Top C 22 0402R
Chipres 0W06
jumper 0402 0R ~

R4414 Bottom G 4 0402R
Resistor 5%
63mW 100k ~

R4423 Bottom I 2
0805R_THER
M1

CHIPRES
0W125 4R7 J
0805 4R7 ~
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R4430 Bottom B 14 0402R
Resistor 5%
63mW 100k ~

R4432 Bottom D 11 0402R
Chipres 0W06
jumper 0402 0R ~

R4438 Bottom D 14 0402R
Resistor 5%
63mW 3k3 ~

R4439 Bottom D 14 0402R
Resistor 5%
63mW 3k3 ~

R4440 Bottom D 14 0402R
Resistor 5%
63mW 3k3 ~

R4441 Bottom H 3 0402R
Resistor 5%
63mW 82k ~

R4444 Bottom I 5 0402R
Chipres 0W06
5% 0402 3M3 ~

R4506 Bottom B 17 0402R
Chipres 0W06
jumper 0402 0R ~

R4507 Bottom B 17 0402R
Chipres 0W06
jumper 0402 0R ~

R4508 Bottom B 17 0402R
Chipres 0W06
jumper 0402 0R ~

R4509 Bottom B 16 0402R
Chipres 0W06
jumper 0402 0R ~

R5201 Bottom M 10 0402R
Resistor 5%
63mW 100k ~

R5202 Bottom L 10 0402R
Resistor 5%
63mW 100k ~

R5203 Bottom M 11 0402R
Resistor 5%
63mW 100k ~

R5204 Bottom L 11 0402R
Resistor 5%
63mW 2k2 ~

R6030 Bottom L 3 0402R
Resistor 5%
63mW 10k ~

R6031 Bottom K 4 0402R
Resistor 5%
63mW 10k ~

R6032 Bottom L 4 0402R
CHIPRES 0W06
2R2 J 0402 2R2 ~

R6034 Bottom K 3 0402R
Resistor 5%
63mW 10k ~

R6035 Bottom K 4 0402R
Resistor 5%
63mW 100k ~
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Item Side Grid reference Description and value

R6302 Bottom H 1 0402R
Chipres 0W06
jumper 0402 0R ~

R7501 Bottom G 12 0402R
Resistor 5%
63mW 2k2 ~

R7502 Bottom H 13 0402R
CHIPRES 0W06
10K F 0402 10k ~

R7503 Bottom F 13 0402R
Resistor 5%
63mW 4k7 ~

R7504 Bottom F 12 0402R
Chipres 0W06
jumper 0402 0R ~

R7505 Bottom G 12 0402R
CHIPRES 0W06
8K2 F 0402 8k2 ~

R7506 Bottom F 13 0402R
Resistor 5%
63mW 10R ~

R7507 Bottom H 13 0402R
Resistor 5%
63mW 10R ~

R7508 Bottom F 12 0402R
Resistor 5%
63mW 10R ~

R7509 Bottom F 12 0402R
Resistor 5%
63mW 22k ~

R7510 Bottom F 17 0402R
Resistor 5%
63mW 15R ~

R7522 Bottom F 16 0402R
CHIPRES 0W06
27K F 0402 27k ~

R7523 Bottom H 16 0402R
Chipres 0W06
jumper 0402 0R ~

R7586 Bottom L 4 0402R
Resistor 5%
63mW 330R ~

R7587 Bottom M 3 0402R
Chipres 0W06
jumper 0402 0R ~

R7588 Top J 23 0402R
Chipres 0W06
jumper 0402 0R ~

R7590 Bottom M 4 0402R
Resistor 5%
63mW 1k8 ~

R7591 Top J 22 0402R
Chipres 0W06
jumper 0402 0R ~

R7592 Bottom L 4 0402R
Resistor 5%
63mW 27k ~

R7594 Bottom M 3 0402R
Resistor 5%
63mW 1k2 ~
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Item Side Grid reference Description and value

S4401 Top L 22
BUTTON_EV
PAA

SWITCH PB
LIGHT EVPAA
15V 20MA ~ ~

T7501 Bottom G 12
TRANS_LDB1
5

TRANSF BALUN
3800
+-550MHZ
0805 ~ ~

T7520 Bottom H 17
TRANS_LDB1
5

TRANSF BALUN
1800
+-100mhz
2x1.25 ~ ~

V2302 Bottom B 5 SOD323F
SCH DI 30V 2A
SOD323F ~ ~

V4400 Top B 22
PT202MR0M
P

DI PHOTO
PT202MR0MP
620NM 1.25X2 ~ ~

V4401 Bottom I 4 SC_76

DI ZEN 100V
6% 200MW
SOD323 ~ ~

V4402 Bottom J 4 SC_76

DI ZEN 100V
6% 200MW
SOD323 ~ ~

V4403 Bottom E 14 VMT3

TR
2SC5658QRS N
50V 0A1 0W15
VMT3 ~ ~

V4404 Bottom H 4 SOT_666

TRX2+RX4
PEMD9 N&P
10K/47K 0W12
SOT666 ~ ~

V4405 Top B 22 LED_CL191

LED CL-191WB-
D-T WHITE 0`
115MCD 0603 ~ ~

V4406 Top B 22 EM3

TR PDTC114EE
N 50V
RB=RBE=10K
EM3 ~ ~

V4407 Bottom B 14 EM3

TR PDTC114EE
N 50V
RB=RBE=10K
EM3 ~ ~

V7590 Bottom M 3 SOT323
Tr NPN 12V
35mA SOT323 ~ ~
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Item Side Grid reference Description and value

W6300 Bottom G 1
ANT_RENM0
5041

BT/WLAN 1.0
TP ANTENNA
RELEASE ~ ~

X2000 Bottom C 1

CON_JACK_H
R33NK_2DJA
_2S

CONN DC-JACK
2.0MM 3POL
SPR 90DEG ~ ~

X2001 Bottom K 2
USB_MITSU
MI_R415082

SMD CONN
5POL MINI-USB
B TYPE P0.8 ~ ~

X2002 Bottom E 2
JACK_T_378
840_A9

HEADSET JACK
4-POLE ~ ~

X2070 Bottom I 18
LYNX_BATT_
CONN_H7.0

SM BATTERY
CONN 3POL
SPR 12V 2A ~ ~

X2100 Bottom D 20
CONN_ANT_
DMD11562

CON PPP
ANTENNA
R1024
DMD11562 ~ ~

X2101 Bottom D 20
CONN_ANT_
DMD11562

CON PPP
ANTENNA
R1024
DMD11562 ~ ~

X2701 Bottom C 15

SIM_CONN_
M_SK_20030
0383

SM SIM CONN
2X3POL P2.54
H4.6 ~ ~

X4400 Top E 22
JST_R_JAVK_
G_1_R3

SM CONN
2X12F P0.4
30V .3A PWB/
PWB ~ ~

X4500 Bottom F 8
CONN_SD_54
742_002

SM LCD CONN
1X8 P2.0 SPR
50V 0.5A ~ ~

X4501 Bottom B 17
SMK_4309_B
_B_6P_V2

SM CONN 6P
SPR P1.3 50V
BTOB ~ ~

X5200 Bottom K 15
MINISD_SC1
S011V1S3

CONN MINISD
PUSH-PUSH
3.3V 0.5A ~ ~

X7504 Bottom M 23
SPRING_WN
9149_N10

C-SPRING
ANTENNA
active ~ ~

X7505 Bottom L 23
SPRING_WN
9149_N10

C-SPRING
ANTENNA
active ~ ~
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Item Side Grid reference Description and value

X7507 Bottom J 23
SPRING_WN
9149_N10

C-SPRING
ANTENNA
active ~ ~

Z2001 Bottom I 3
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

Z2002 Bottom H 3
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

Z2003 Bottom F 3
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

Z2004 Bottom F 3
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

Z2005 Bottom E 3
FERRITE_04
02

FERRITE BEAD
0.6R 600R/
100MHZ 0402

600R/
100MHz ~

Z4402 Top B 23
uBGA25_2.4
7X2.47

ASIP 10-CH ESD
EMI FILTER
BGA25 ~ ~

Z4403 Top C 23
uBGA25_2.4
7X2.47

ASIP 10-CH ESD
EMI FILTER
BGA25 ~ ~

Z4500 Bottom B 13
uBGA24_2.6
2X2.62

ASIP
EMIF10-1K010
F2 **PB-
FREE** ~ ~

Z4501 Bottom D 12
uBGA24_2.6
2X2.62

ASIP
EMIF10-1K010
F2 **PB-
FREE** ~ ~

Z5200 Bottom M 12
uBGA11_1.6
2X2.12

ASIP EMIF04-
MMC02F2**PB
-FREE** ~ ~

Z6030 Bottom K 4
EZFVQ42NM
61S

LTCC FILT
2441.75
+-41.75MHZ
2.5X2

2441.75MH
z ~

Z7501 Bottom G 15

FILTER_2.1X
1.7_10P_H0.
6

SAW FILT
1842.5/1960M
HZ 2.0X1.6MM

1842.5/196
0MHZ ~
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Item Side Grid reference Description and value

Z7503 Bottom F 15

MODULE_LM
SM43AA_34
1

TX SAW
MODULE GSM
850/900MHZ
4.5X3.2

850/900MH
z ~

Z7504 Bottom G 15

FILTER_2.1X
1.7_10P_H0.
65

DUAL RX SAW
FILTER
850/900MHZ
2016

850/900MH
z ~

Z7520 Bottom H 16
FERRITE_FB
MJ1608

FERRITE BEAD
0R01 28R/
100MHZ 0603

28R/
100MHz ~
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 Component layouts

Components overview
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Component layout - bottom (1qr_10a_asmdrw_b)
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Component layout - top (1qr_10a_asmdrw_t)
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 Phoenix installation steps in brief

Prerequisites
Recommended hardware requirements:

• Computer processor: Pentium 700 MHz or higher

• RAM 256 MB

• Disk space 100-300 MB

Supported operating systems:

• Windows 2000 Service Pack 3 or higher

• Windows XP Service Pack 1 or higher

Context
Phoenix is a service software for reprogramming, testing and tuning phones.

Phoenix installation contains:

• Service software support for all phone models included in the package

• Flash update package files for programming devices

• All needed drivers for:

• PKD-1 (DK2) dongle

• DKE-2 USB cable

Note: Separate installation packages for flash update files and drivers are also available, but it is
not necessary to use them unless there are updates between Phoenix service software releases. If
separate update packages are used, they should be used after Phoenix and data packages have been
installed.

The phone model specific data package includes all changing product specific data:

• Product software binary files

• Files for type label printing

• Validation file for the faultlog repair data reporting system

• All product specific configuration files for Phoenix software components

Note: Phoenix and phone data packages should only be used as complete installation packages.
Uninstallation should be made from the Windows Control Panel.

To use Phoenix, you need to:

Steps
1. Connect a PKD-1 (DK2) dongle to the computer parallel port.

2. Install Phoenix.

3. Install the phone-specific data package.

4. Configure users.

5. Manage connection settings (depends on the tools you are using).

• Update FPS-10 software

Note: There is no need to activate FPS-10.

• Activate SX-4 smart card, if you need tuning and testing functions.

Note: When FPS-10 is used only for product software updates, SX-4 smart card is not needed.
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Results
Phoenix is ready to be used with FPS-10 flash prommer and other service tools.

 Installing Phoenix

Prerequisites
• Check that a dongle is attached to the parallel port of your computer.

• Download the Phoenix installation package (for example, phoenix_service_sw_2004_39_x_xx.exe) to your
computer (in C:\TEMP, for instance).

• Close all other programs.

• Depending on your operating system, administrator rights may be required to install Phoenix.

• If uninstalling or rebooting is needed at any point, you will be prompted by the InstallShield program.

Context
At some point during the installation procedure, you may get the following message:

Figure 3 Dongle not found

This may be a result of a defective or too old PKD-1 dongle.

Check the COM/parallel ports used. After correcting the problem, you can restart the installation.

For more detailed information, please refer to Phoenix Help files.

Tip: Each feature in Phoenix has its own Help function, which can be activated while running the
program. Press the F1 key or the feature’s Help button to activate a Help file.

Steps
1. To start the installation, run the application file (for example,phoenix_service_sw_2004_39_x_xx.exe).

2. In the Welcome dialogue, click Next.

RM-88
Nokia Customer Care Service Software Instructions

Page 3 –6 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



3. Read the disclaimer text carefully and click Yes.

Figure 4 Disclaimer text

4. Choose the destination folder.

The default folder C:\ProgramFiles\Nokia\Phoenix is recommended.

5. To continue, click Next.

To choose another location, click Browse (not recommended).

6. Wait for the components to be copied.

The progress of the installation is shown in the Setup Status window.

7. Wait for the drivers to be installed and updated.

The process may take several minutes to complete.

If the operating system does not require rebooting, the PC components are registered right away.

If the operating system requires restarting your computer, the Install Shield Wizard will notifies about it.

Select Yes... to reboot the PC immediately or No... to reboot the PC manually afterwards.

After the reboot, all components are registered.

Note: Phoenix does not work, if the components have not been registered.
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8. To end the installation, click Finish.

Figure 5 InstallShield Wizard Complete

Next actions
After the installation, Phoenix can be used after:

• installing phone model specific data package for Phoenix
• configuring users and connections

FPS-10 flash prommer can be used after updating their flash update package files.

 Updating Phoenix installation

Context
• If you already have the Phoenix service software installed on your computer, you need to update the

software when new versions are released.

• To update Phoenix, you need to follow the same steps as when installing it for the first time.

• When you are updating, for example, from version a14_2004_16_4_47 to a15_2004_24_7_55, the update
will take place automatically without uninstallation.

• Always use the latest available versions of both Phoenix and the phone-specific data package. Instructions
can be found in the phone model specific Technical Bulletins and phone data package readme.txt files
(shown during installation).

• If you try to update Phoenix with the same version you already have (for example, a15_2004_24_7_55
to a15_2004_24_7_55), you are asked if you want to uninstall the existing version. In this case you can
choose between a total uninstallation or a repair installation in a similar way when choosing to uninstall
the application from the Windows Control Panel.

• If you try to install an older version (for example, downgrade from a15_2004_24_7_55 to
a14_2004_16_4_47), installation will be interrupted.
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Figure 6 Installation interrupted

• Always follow the instructions on the screen.

Steps
1. Download the installation package to your computer hard disk.

2. Close all other programs.

3. Run the application file (for example, phoenix_service_sw_2004_39_x_xx.exe).

Results
A new Phoenix version is installed and driver versions are checked and updated.

 Uninstalling Phoenix

Context
You can uninstall Phoenix service software manually from the Windows Control Panel.

Steps
1. Open the Windows Control Panel, and choose Add/Remove Programs.
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2. To uninstall Phoenix, choose Phoenix Service Software→Change/Remove→Remove .

Figure 7 Remove program

The progress of the uninstallation is shown.

3. If the operating system does not require rebooting, click Finish to complete.

Figure 8 Finish uninstallation
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If the operating system requires rebooting, InstallShield Wizard will notify you. Select Yes... to reboot the
PC immediately and No... to reboot the PC manually afterwards.

 Repairing Phoenix installation

Context
If you experience any problems with the service software or suspect that files have been lost, use the repair
function before completely reinstalling Phoenix.

Note: The original installation package (for example, phoenix_service_sw_a15_2004_24_7_55.exe)
must be found on your PC when you run the repair setup.

Steps
1. Open Windows Control Panel→Add/Remove Programs .

2. Choose Phoenix Service Software→Change/Remove .

3. In the following view, select Repair.

Figure 9 Repair program

Phoenix reinstalls components and registers them.

The procedure is the same as when updating Phoenix.

4. To complete the repair, click Finish.

 Phone data package overview
Each product has its own data package (DP). The product data package contains all product-specific data files
to make the Phoenix service software and tools usable with a certain phone model.

The phone data package contains the following:

• Product software binary files
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• Files for type label printing

• Validation file for the fault log repair data reporting system

• All product-specific configuration files for Phoenix software components

Data files are stored in C:\Program Files\Nokia\Phoenix (default).

 Installing phone data package

Prerequisites
• A phone-specific data package contains all data required for the Phoenix service software and service tools

to be used with a certain phone model.

• Check that a dongle is attached to the parallel port of your computer.

• Install Phoenix service software.

• Download the installation package (for example, XX-XX_dp_EA_v_1_0.exe) to your computer (for example,
in C:\TEMP).

• Close all other programs.

(XX-XX = type designator of the product)

If you already have Phoenix installed on your computer, you will need to update it when a new version is
released.

Note: Often Phoenix and the phone-specific data package come in pairs, meaning that a certain
version of Phoenix can only be used with a certain version of a data package. Always use the latest
available versions of both. Instructions can be found in phone-specific Technical Bulletins and
readme.txt files of data packages.

Steps
1. To start the installation, run the application file (for example, XX-XX_dp_EA_ v_1_0.exe),

Wait for the installation files to be extracted.

RM-88
Nokia Customer Care Service Software Instructions

Page 3 –12 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



2. Click Next.

3. In the following view you can see the contents of the data package. Read the text carefully. There is
information about the Phoenix version required with this data package.

Figure 10 Data package setup information

4. To continue, click Next.
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5. Choose the destination folder, and click Next to continue.

Figure 11 Data package destination folder

The InstallShield Wizard checks where Phoenix is installed, and the directory is shown.

6. To start copying the files, click Next.
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Phone model specific files are installed. Please wait.

7. To complete the installation, click Finish.

Figure 12 InstallShield Wizard Complete

Next actions
Phoenix can be used for flashing phones and printing type labels after:

• Configuring users

• Managing connections

FPS-10 can be used after updating their flash update package files.

 Uninstalling phone data package

Context
There is no need to uninstall an older version of a data package, unless instructions to do so are given in
the readme.txt file of the data package and bulletins related to the release.

Please read all related documents carefully.

Steps
1. Locate the data package installation file (e.g. XX-XX_dp_EA_v_1_0.exe) from your computer.

2. To start the uninstallation procedure, double-click the data package installation file.
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3. To uninstall the data package, click OK or to interrupt the uninstallation, click Cancel.

Figure 13 Uninstalling phone data package

4. When the data package is uninstalled, click Finish.

Figure 14 Finishing data package uninstallation

Alternative steps
• You can also uninstall the data package manually from

Control Panel→Add/Remove Programs→xx-xx* Phone Data Package . (*= type designator of the
phone).
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 Configuring users in Phoenix

Steps
1. Start Phoenix service software, and log in.

Figure 15 Phoenix login

If the user ID is already configured, select s/he from the User name drop-down list, and click OK.

2. To add a new user, or to edit existing ones, click Maintain.

3. To add a new user, click New.

4. Type in the name and initials of the user, and click OK.

The user is added to the user name list.

5. Select the desired user from the User name drop-down list, and click OK.

Figure 16 New user configured

 Managing connections in Phoenix

Context
With the Manage Connections feature you can edit and delete existing connections or create new ones.

Note: After choosing the desired connection, and connecting the phone to a PC for the first time,
allow the PC to install the USB device drivers first. Please note that this may take some time to
complete.

If there are problems after the driver installation, check that the USB connection is active from
the Windows Control Panel. If the problem persists, contact the local PC support.

Steps
1. Start Phoenix, and log in.

2. Choose File→Manage Connections... .
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3. To add a new connection, click Add.

4. Select Manual mode, and click Next to continue.

If you want to create the connection using the Connection Wizard, connect the tools and a phone to your
PC. The wizard will automatically try to configure the correct connection.

Figure 17 Select mode: Manual

i For an FPS-10 flash prommer with a USB Connection, choose the following connection settings:

• Media: FPS-10 USB

• DEVICE_INDEX: 0

• SERIAL_NUM: See Serial No from the label attached to the bottom of FPS-10

• ACTIVE_MEDIA: USB

ii For an FPS-10 flash prommer with a LAN connection, choose the following connection settings:

• Media: FPS-10 TCP/IP

• NET_SERV_NAME: Click Scan.... Choose your own FPS-10 device based on the correct MAC address.
See Serial No from the label attached to the bottom of your FPS-10.

• PORT_NUM: Use the default value, and click Next.

• PROTOCOL_FAMILY: Use the default value, and click Next.

• SOCKET TYPE: Use the default value, and click Next.

• TX_BUFFER_SIZE: Use the default value, and click Next.

• RX_BUFFER_SIZE: Use the default value, and click Next.

iii For an FPS-8 flash prommer, choose the following connection settings:

• Media: FPS-8

• PORT_NUM: COM Port where FPS-8 is connected

• COMBOX_DEF_MEDIA: FBUS
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iv For a plain USB connection, choose the following connection settings:

Note: First connect the DKE-2 USB cable between the PC USB port and phone.

• Media: USB

5. To complete the configuration, click Finish.

6. Click the connection you want to activate. Use the up/down arrows located on the right hand side to move
it on top of the list, then click Apply.

Figure 18 Connections list

The connection is activated, and it can be used after closing the Manage Connection window.

The connection information is shown at the right hand bottom corner of the screen.

Figure 19 Connection information

7. To use the connection, connect the phone to your PC with correct service tools. Make sure the phone is
switched on, and then choose File→Scan Product .

Results
The product support module information appears in the status bar:

Figure 20 Product support module information (example from RM-1)

 Installing flash support files for FPS-10

Prerequisites
Note: You need to install flash support files for FPS-10 only, if you don’t have the latest Phoenix
available or the flash support files have changed after the latest Phoenix release.

• Flash support files are installed automatically, when you install Phoenix. Use Phoenix packages later than
June 2006.

• Normally it is enough to install Phoenix and the phone-specific data package because the Phoenix
installation always includes the latest flash update package files for FPS-10.

• A separate installation package for flash support files is available, and the files can be updated according
to this instruction, if updates appear between new Phoenix / data package releases

Context
If you are not using a separate installation package, you can skip this section and continue with [[[ERROR:
Unable to generate link title]]] (page ) after installing a new phone data package.
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Steps
1. To begin installation, double- click flash_update_x_yy.exe .

Figure 21 Flash update welcome dialog

If the same version of Flash Update package already exists, and you want to reinstall it, the previous
package is first uninstalled. Restart installation again after that.

2. If you try to downgrade the existing version to older ones, the setup will be aborted. If you really want
to downgrade, uninstall newer files manually from Control Panel and then rerun the installation again.

Figure 22 Flash installation interrupted

If an older version exists on your PC and it needs to be updated, click Next to continue installation.
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3. It is highly recommended to install the files to the default destination folder C:\Program Files\Nokia
\Phoenix. Click Next to continue.

Figure 23 Flash destination folder

When installing the flash update files for the first time you may choose another location by selecting
Browse. However, this is not recommended.
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4. To complete the installation procedure, click Finish .

Figure 24 Finish flash update

Next actions
FPS-10 flash prommers must be updated using Phoenix!

 Updating FPS-10 flash prommer software

Steps
1. Start Phoenix Service Software and log in, manage connection correctly for your flash prommer.

2. Choose Flashing→Prommer maintenance .

3. When the new flash update package is installed to the computer you will be asked to update the files to
your Prommer. To update the files, click Yes. Click OK if the computer informs you about an unsafe removal
of the device.

4. Alternatively you can update the FPS-10 flash prommer software by clicking the Update button.

RM-88
Nokia Customer Care Service Software Instructions

Page 3 –22 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



5. Wait until you are notified that update has been successful; the procedure will take a couple of minutes.
Click OK to close the Update Done window.

Figure 25 Prommer SW update finished

6. If you are using the FPS-10 flash prommer, check that it is detected from the progress info. Check also the
status leds in the FPS-10. The MODE2 led (green), VBAT and POWER leds (red) should be lit. If you are using
LAN connection, the LAN led (yellow) should be blinking.

7. Check that your FPS-10 flash prommer has enough memory. Flashing the RM-88 with FPS-10 needs at least
128 MB of SRAM memory in the prommer.

Figure 26 Prommer maintenance window
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Alternative steps
• You can update FPS-10 SW by clicking the Update button and selecting the appropriate fpsxupd.ini file

in C:\Program Files\Nokia\Phoenix\Flash.

Figure 27 Flash directory window

• All files can be loaded separately to the prommer used. To do this, click the right mouse button in the
Flash box files window and select the file type to be loaded.

More information can be found in Phoenix Help.
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 Service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-88, refer to various concepts.

AC-34 Universal power
supply

Universal power supply

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.

CA-56RS RF cable

Small RF cable that is used for RF tuning with MJ-67 module jig.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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DKE-2 Mini-USB cable

USB to mini-USB connector cable.

FLS-4S Flash device

FLS-4S is a dongle and flash device incorporated into one package,
developed specifically for POS use.

FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable
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FS-5 Product specific
adapter

RM-88/RM-89 specific adapter.

MJ-67 Module jig

RM-88/RM-89 specific module jig.

• Table 7 Attenuation table for MJ-67

System Channel Tx/Rx-att. (dB)

GSM 850 128 0.2

190 0.1

251 0.1

GSM 900 975 0.1

38 0.1

124 0.2

GSM 1800 512 0.3

698 0.2

885 0.1

GSM 1900 512 0.5

700 0.6

810 0.8

Measured with Universal Radio Communication Tester CMU-200.

Note: Tx-attenuation tolerance is +/- 0.5dB

Rx-attenuation tolerance is +/- 1.0 dB

RJ-86 Soldering jig

RM-88/RM-89 specific soldering jig.

RM-88
Nokia Customer Care Service Tools and Service Concepts

Page 4 –8 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



SA-82 Flash adapter
antenna coupler

RM-88/RM-89 specific flash adapter antenna coupler.

• Flash adapter antenna coupler SA-82 attenuation table for NOKIA
E62, measured with Universal Radio Communication Tester
CMU-200.

Table 8 Attenuation table for antenna coupler SA-82

System Channel Tx-att. (dB) Rx-att. (dB)

GSM 850 128 5.8 4

190 5.3 3

251 5.3 3

GSM 900 975 5.8 4

38 5 4

124 5 4

GSM 1800 512 7.7 6

698 7.4 6

885 7.2 5

GSM 1900 512 7.9 6

700 6.2 6

810 5.6 6

Note: Tx-attenuation tolerance is +/-0.5 dB.

Rx-attenuation tolerance is +/-1.0dB.

SRT-6 Opening tool

SRT-6 is used to open phone covers and B-to-B connectors.
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SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SS-76 Domesheet assembly
jig
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 Service concepts

Flash concept with FPS-10

Figure 28 Basic flash concept with FPS-10

Description Type

FS-5 Flash adapter

SS-46 Interface adapter

CA-35S Power cable

XCS-4 Modular cable

Standard USB cable

FPS-10 Flash prommer box

Standard USB cable

PKD-1 SW security device
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MJ-67 module jig concept

Figure 29 MJ-67 module jig service concept

Type Description

MJ-67 Module jig

CU-4 Control unit

FPS-10 Flash prommer box

SX-4 Smart card

XCS-4 Modular cable

PCS-1 DC power cable

Standard USB cable

Standard USB cable

GPIB control cable

XRS-6 RF cable

PKD-1 SW security device

RF shield box
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POS (Point of Sale) flash concept

Figure 30 POS flash concept

Type Description

CA-53 USB connectivity cable

FLS-5 POS flash device

ACP-8 Power adapter
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Service concept for RF testing and RF/BB tuning

Figure 31 Service concept for RF testing and RF/BB tuning

Description Type

MJ-67 Module jig

CU-4 Control unit

Standard USB cable

PCS-1 DC power cable

Standard USB cable + smart card reader

SX-4 Smart card

XRS-6 RF cable

GPIB control cable

PKD-1 SW security device

RF shield box
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CU-4 flash concept with FPS-10

Figure 32 CU-4 flash concept with FPS-10

Note: FPS-8 concept can also be used for flashing.

Description Type

SS-62/FS-5 Flash adapter

CU-4 Control unit

XCS-4 Modular cable

PCS-1 Power cable

FPS-10 Flash prommer box

Standard USB cable

Standard USB cable

PKD-1 SW security device
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RF testing and BB testing/tuning

Figure 33 RF testing concept and BB testing/tuning

Type Description

SS-62/FS-5 Flash adapter

CU-4 Control unit

SA-82 RF coupler

PCS-1 Power cable

XCS-4 Modular cable

Standard USB cable

Standard USB cable + smart card reader

SX-4 Smart card

GPIB control cable

XRS-6 RF cable

PKD-1 SW security device

RF shield box
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 Tips for assembly
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 Introduction to baseband troubleshooting
This chapter outlines the troubleshooting process for any baseband related problems reported from our
customer. All troubleshooting by service technicians will be limited to those parts that are not under any
shields.

Basic Troubleshooting for RM-88
The most likely problems that may be reported with RM-88 engine are listed below.

• Phone does not power up or gets jammed during startup.

• Abnormal current consumption.

• Flashing does not work.

• Charging does not work.

• Display does not work.

• Keypad does not work.

• Display backlight does not work.

• Keyboard EL dome sheet does light up.

• Mail indicator LED does not work.

• Phone gives SIM card error.

• Phone cannot access SD card.

• USB does not work.

• Audio (earpiece, microphone, and/or IHF) does not work.

• Audio headset does not work.

• Volume key does not work.

• Bluetooth does not work.

• IRDA does not work.
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 Baseband main troubleshooting

Troubleshooting flow
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 General power checking troubleshooting

Troubleshooting flow
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 Battery current measuring fault troubleshooting

Troubleshooting flow
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 Flash programming fault troubleshooting

Troubleshooting flow

Figure 34 Flashing pic 1. Take single trig measurement for the rise of the BSI signal.

Figure 35 Flashing pic 2. Take single trig measurement for the rise of the BSI signal.

 Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys can be stuck, so that the key does not react when a keydome is pressed. This kind of
failure is caused by mechanical reasons (dirt, corrosion).
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• Malfunction of several keys at the same time; this happens when one or more rows or columns are faulty
(shortcut or open connection). For a more detailed description of the keyboard and keymatrix, see
section Keyboard in System Module.

If the failure mode is not clear, start with the Keyboard Test in Phoenix.

Troubleshooting flow
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 USB interface troubleshooting

Troubleshooting flow
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 Charging troubleshooting

Troubleshooting flow
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 Dead or jammed troubleshooting

Troubleshooting flow
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 IrDA troubleshooting

Troubleshooting flow
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 Vibra troubleshooting

Troubleshooting flow
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 MiniSD troubleshooting

Troubleshooting flow
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 SIM troubleshooting

Troubleshooting flow
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 Display module troubleshooting

General instructions for display troubleshooting
The first step is to verify with a working display that the fault is not on the display module itself. The display
module cannot be repaired.

The second step is to check that the cellular engine is working normally. This can be done by connecting the
phone to a docking station and starting Phoenix service software. With the help of Phoenix read the phone
information to check that also the application engine is functioning normally (you should be able to read the
APE ID).

After these checks proceed to the display troubleshooting flowcharts. Use the Display Test tool in Phoenix to
find the detailed fault mode.

Operating modes of the display
The display is in a normal mode when the phone is in active use.

The display is in a partial idle mode when the phone is in the screen saver mode.

The operating modes of the display can be controlled with the help of Phoenix.

Table 9 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone. Backlight is also
controlled automatically by the ambient light
sensor.

This means that in case the display is working
(image OK), but the backlight is not, follow the
Display and Keyboard Backlight troubleshooting.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.
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Table 10 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect
counts

R G B White
Dot
Total

1 1

1 1 1 1

2 Combine
d defect
counts

Not allowed.

Two single dot defects that are within 5 mm of each other should
be interpreted as combined dot defect.

Note: Blinking pixels are not allowed in normal operating temperatures and light conditions.
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Display fault troubleshooting

Troubleshooting flow

RM-88
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 6 –20 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Display and keyboard backlight troubleshooting

Context
The device has one LED driver that provides current for the display backlight.

The brightness of the display is adjusted by the Ambient Light Sensor (ALS).

You can enable/disable ALS with the help of Phoenix service software.

Display brightness can be adjusted manually, if ALS is disabled. If the ambient light sensor is enabled, it
adjusts the display brightness automatically.
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Troubleshooting flow
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Related information
• Display fault troubleshooting (page 6–20)

• LED driver troubleshooting (page 6–28)

• ALS troubleshooting (page 6–25)
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EL backlight fault troubleshooting

Troubleshooting flow
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ALS troubleshooting

Context
• If a phototransistor is broken, replace it with a typical phototransistor.

• After replacing the phototransistor or if calibration values are lost for some other reason, ALS re-tuning is
required.

• Before starting the ALS calibration procedure, perform the 'Pull-up resistor calibration' in dark lighting
conditions, and write the measured 'correction' value to the phone. After this ALS calibration procedure
is performed, and the default co-efficient value '1' is written to the phone.

• Make sure that you have completed Display and keypad backlight troubleshooting first before
starting ALS troubleshooting.

Here are some hints for ALS troubleshooting; the following troubleshooting diagram refers to these:

• Phoenix LED control tool also shows you luminance. The correct luminance in darkness is <20 lx, and in
office environment 100-2000 lx. The luminance value depends strongly on the light source and the angle
of the phone, so these values are only a rough guideline.

• LED driver control voltage measurement points can be found from the LED driver troubleshooting
section. When backlight brightness is set to 100%, both GENOUT signals are low, and enable PWM is 100%.

• Phoenix has an ambient light sensor calibration tool for changing calibration values. The pull-up resistor
calibration is done first. See the following procedure.
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Steps
1. Cover the light guide (upper part of the A-Cover).

2. Start Phoenix.

3. Choose File→Scan Product.

4. Choose Tuning→Ambient Light Sensor Calibration.

Figure 36 Ambient Light Sensor Calibration window

5. In the Pull Up Resistor Calibration pane, click Start, and Write.

6. In the Ambient Light Sensor Calibration pane, check the Use default values only check box, and click
Write.

7. To end the calibration, click Close.
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Troubleshooting flow
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LED driver troubleshooting

Troubleshooting flow
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 Bluetooth troubleshooting

Introduction to Bluetooth troubleshooting
There are two main Bluetooth problems that can occur:

Problem Description

Detachment of the BT antenna. This would most likely happen if the device has
been dropped repeatedly to the ground. It could
cause the BT antenna to become loose or partially
detached from the PWB. (see next page for details
about BT antenna HW and Mechanics)

A malfunction in the BT ASIC, BB ASICs or Phone’s BT
SMD components.

This is unpredictable and could have many causes
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the BT system or the
phone’s BB and then replace/fix the faulty component.

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.

4. Choose Testing→Bluetooth LOCALS .

5. Locate JBT-9’s serial number (12 digits) found in the type label on the back of JBT-9.

In addition to JBT-9, also SB-6, JBT-3 and JBT-6 Bluetooth test boxes can be used.

6. In the Bluetooth LOCALS window, write the 12-digit serial number on the
Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.

7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in the Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window.
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Figure 37 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. ChooseFile→Scan Product.

3. Place the phone to a flash adapter.

4. From the Mode drop-down menu, set mode to Local.

5. Choose Testing→Self Tests.

6. In the Self Tests window check the following Bluetooth related tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST
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7. To run the tests, click Start.

Figure 38 Bluetooth self tests in Phoenix
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Bluetooth BER failure troubleshooting

Troubleshooting flow
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BT audio failure troubleshooting

Troubleshooting flow
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 Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or
a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• Current probe (Internal handsfree PWM output measurement)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:

• External microphone to Internal earpiece

• External microphone to Internal handsfree speaker

• Internal microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.

Loop test Input terminal Output
terminal

Path
gain
[dB]

(fixed)

Input
volta

ge
[mVp-

p]

Differen
tial

output
voltage
[mVp-p]

Outpu
t DC

level
[V]

Outp
ut

curre
nt

[mA]

External Mic to Internal
Earpiece

XMICP and GND EarP and GND 35 100 920 1.2 NA

EarN and
GND

RM-88
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 6 –34 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Loop test Input terminal Output
terminal

Path
gain
[dB]

(fixed)

Input
volta

ge
[mVp-

p]

Differen
tial

output
voltage
[mVp-p]

Outpu
t DC

level
[V]

Outp
ut

curre
nt

[mA]

External Mic to Internal
Handsfree

XMICP and GND B2102 pads 32 100 - 0 80m
A +/-
10m
A

Internal Mic to External
Earpiece

B2100 (OUT/
GND)

XEARL and
GND

35 100 1360 0 NA

XEARR and
GND

Measurement data

Figure 39 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.

Figure 40 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.
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Figure 41 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow

RM-88
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 6 –38 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



IHF troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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Introduction to acoustics troubleshooting

Acoustics troubleshooting
Acoustics design ensures that the sound is detected correctly with a microphone and properly radiated to
the outside of the device by speaker(s). The acoustics of the phone includes three basic systems: earpiece,
Integrated Hands Free (IHF) and microphone.

The sound reproduced from the earpiece readiates through a single hole on the front cover (A-cover). The
sound reproduced from the IHF speakers radiates from the sound holes on the bottom of the lower block.
The hole of the microphone is located between the upper and the lower block, on the right side..

For a correct functionality of the phone, all sound holes must be always open. When the phone is used, care
must be taken not to close any of those holes with a hand or fingers. The phone should be dry and clean,
and no objects must be located in such a way that they close any of the holes.
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Earpiece troubleshooting

Troubleshooting flow
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Acoustics IHF troubleshooting

Troubleshooting flow
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Microphone troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 11 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

IBAT (ICal) Gain 5750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 Introduction to RF troubleshooting
All measurements should be done using:

• spectrum analyser with a high-frequency high-impedance passive probe (LO-/reference frequencies and
RF power levels)

• oscilloscope with a 10:1 probe (DC-voltages and low frequency signals)

The RF section of the phone is around RF ASIC N7505, TX FEM N7520, and all of this RF section is built inside
of non-removable shields A7506, A7507. Therefore, the engine will be replaced after carefully checked power
and receiver tuning at antenna port.

 RF key component placement
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Figure 42 RM-88 RF components
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Figure 43 RM-88 BT component placement
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Figure 44 RM-88 component placement (top)

Figure 45 RM-88 component placement (bottom)
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 Receiver troubleshooting

Introduction to Rx troubleshooting
Rx can be tested by making a phone call or in the local mode. For the local mode testing, use Phoenix service
software.

The main Rx troubleshooting measurement is RSSI measurement. This test measures the signal strength of
the received signal.

In GSM, the input signal can be either a real GSM signal or a CW (Continuous Wave) signal, which is 67.771
kHz above the carrier frequency.

For service tool usage instructions, refer to section Service Tools and Service Concepts.

General instructions for RX troubleshooting

Steps
1. Connect a test jig to a computer with a DKE-2 cable or to a FPS-10 flash prommer with a modular cable

(XCS-4).

Make sure that you have a PKD-1 dongle connected to the computer's parallel port.

2. Connect a DC power supply to a module test jig (MJ-67).

Note: Set the DC supply voltage to 12 V and set the jumper connector on the test jig's reg.pass
switch to “ON” position.

3. Connect an RF cable between the RF connector of the module test jig (MJ-67) and measurement equipment
or alternatively use a 50 ohms (at least 2 W) dummy load in the module test jig RF connector, otherwise
GSM may be damaged.

Note: Make sure that all connections are made to the correct RF connector.

4. Set Rx on.

i Set the phone module to the test jig and start Phoenix service software.

ii Initialize connection to the phone. (With FPS-10 use FBUS driver when using DKE-2 and COMBOX driver).

iii From the File menu, choose product: File -> Choose Product -> xx-x* (* = type designator of the
phone, scan product).

iv From the toolbar, set operating mode to “Local”.

5. EGSM900, GSM850/1800/1900 troubleshooting

i From the Testing menu, activate the RF Controls window:  Testing -> GSM -> RF Controls .

ii In the RF Controls window:

• Select band "GSM850", “GSM900” or “GSM1800” or “GSM1900” (Default = “GSM850”).

• Set Active unit to “Rx” (Default = “Rx”).

• Set Operation mode to “Burst” (Default = “Burst”).
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• Set Rx/Tx channel to 190 on GSM850, 37 on GSM900 band or 700 on GSM1800 band or 661 on GSM1900
(Defaults).

• Set Edge to “Off” (Default). (Not active in RXmode).

• Set Tx PA mode to “Free” (Default). (Not active in RXmode).

• Apply 942.46771 MHz (channel 37 + 67.710 kHz offset), 881.66771MHz (channel 190 + 67.710 kHz),
1842.86771 MHz (channel 700 + 67.710 kHz offset) or 1960.06771 MHz (channel 661 + 67.71 kHz) –
90 dBm signal to the RF-connector (remember to compensate for cable attenuation).

Figure 46 RF Controls window

GSM Rx chain activation for manual measurements / GSM RSSI measurement

Context
RSSI signal measurement is the main Rx troubleshooting measurement. The test measures the strength of
the received signal.

Steps
1. Start Phoenix service software.

2. Choose Testing→GSM→RSSI Reading .

3. Set the RF signal generator for channel frequency +67.771 kHz CW mode with –80 dBm signal.

Alternatively set the cellular tester downlink channel to the appropriate channel. Make sure that the tester
is set to continuous mode, not to burst mode.
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4. In the RSSI Reading window, select the appropriate band and channel.

Figure 47 RSSI Reading window

5. To start the measurement, activate GSM Rx chain, click Start.

Results
RSSI reading values of the selected band and channel are displayed. The RSSI level must be the same value
which is set at the signal generator (-90 dBm).

If RSSI reading is far away from -90dBm, try to do RX tuning. Change engine if problem still shows up after
re-tuning.

 Transmitter troubleshooting

General instructions for TX troubleshooting

Context
• Tx troubleshooting requires Tx operation.

• Do not transmit on frequencies that are in use!

• Transmitter can be controlled in the local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is "RF Controls".

• Remember that retuning is not a fix! Phones are tuned correctly in production.

The first set of steps instructs how to assemble the test setup. This setup is general for all Tx troubleshooting
tasks.

Alternative steps provide specific troubleshooting instructions for Phoenix service software.

Caution: Never activate the GSM transmitter without a proper antenna load. There should be always
50 ohm load connected to the RF connector (antenna, RF-measurement equipment or at least 2
watts dummy load), otherwise GSM PA may be damaged.

Steps
1. Connect a test jig to a computer with a DKE-2 cable or to a FPS-10 flash prommer with a modular cable

(XCS-4).

Make sure that you have a PKD-1 dongle connected to the computer's parallel port.

RM-88
RF Troubleshooting and Manual Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 7 –11
Copyright © 2006 Nokia. All rights reserved.



2. Connect a DC power supply to a module jig (MJ-67).

Note: When repairing or tuning a transmitter, use an external DC supply with at least 3 A current
capability.

Set the DC supply voltage to 12V and set the jumper connector on the test jig's reg.pass switch to
“ON” position.

3. Connect an RF cable between the RF connector of the module test jig (MJ-69) and measurement equipment
or alternatively use a 50 ohms (at least 2 W) dummy load in the module test jig RF connector, otherwise
GSM may be damaged.

Note: There are two antenna connectors in the module jig:

• one for GSM

• one for Bluetooth

Make sure that all connections are made to the correct RF connector.

Normally a spectrum analyser is used as measurement equipment.

Note: The maximum input power of a spectrum analyser is +30 dBm.

To prevent any damage, it is recommended to use 10 dB attenuator on the spectrum analyzer input.

4. Set Tx on.

i Set the phone module to the test jig and start Phoenix service software.

ii Initialize connection to the phone. (With FPS-10 use FBUS driver when using DAU-9S and COMBOX
driver).

iii From the File menu, choose product: File -> Choose Product -> xx-x* (* = type designator of the
phone).

iv From the toolbar, set operating mode to “Local”.

5. EGSM900, GSM850/1800/1900 troubleshooting

i From the Testing menu, activate the RF Controls window:  Testing -> GSM -> RF Controls .

ii In the RF Controls window:

• Select band "GSM850", “GSM900” or “GSM1800” or “GSM1900” (Default = “GSM850”).

• Set Active unit to “Tx” (Default = “Rx”).

• Set Operation mode to “Burst” (Default = “Burst”).

• Set Tx data type to “Random” (Default = “All1”).

• Set Rx/Tx channel to 190 on GSM850, 37 on GSM900 band or 700 on GSM1800 band or 661 on GSM1900
(Defaults).

• Set Edge to “Off” (Default).

• Set Tx PA mode to “Free” (Default).

• Set power level to 5 (Default = 19) on GSM850/900 or to 0 (Default = 15) on GSM1800 or GSM1900.

RM-88
Nokia Customer Care RF Troubleshooting and Manual Tuning Guide

Page 7 –12 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Figure 48 RF Controls window
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TX 850/900 troubleshooting

Troubleshooting flow
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TX 1800/1900 troubleshooting

Troubleshooting flow

Checking antenna functionality
The main antenna has one antenna: GSM .

In the GSM antenna, there is one Feed and two GND contacts.
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The contacts of the GSM antenna are separated in the (RDC = 0 ohm) short-circuit.

Figure 49 Main antenna

Figure 50 Feed and GND spots of the main antenna
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The antenna is functioning normally when the contacts function (RDC = 0 ohm) and the antenna is visually
intact.

BT antenna
BT antenna has one Feed and one GND contact. The antenna is functioning normally when the contacts
function (RDC = 0 ohm) and the antenna is visually intact.

RF tunings

Introduction to RF tunings
Important: Only perform RF tunings if:

• one or more of the RF components is changed

• flash Memory chip is changed or otherwise corrupted.

RF calibration is always performed with the help of a product-specific module jig, never with an RF coupler.
Using an RF coupler in the calibration phase will cause a complete mistuning of the RF side.

Important: After RF component changes, always use autotuning. Manual tunings are only required
in rare cases.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken in account when the phone is tuned. As all
the RF losses are frequency dependent, the user have to be very careful and understand the measurement
setup. In the following table there are RF attenuations of the module jig:

Band Attenuation

GSM850 0.2 dB

GSM900 0.2 dB

GSM1800 0.3 dB

GSM1900 0.6 dB

RF autotuning

Prerequisites
For information on the recommended test set-up, refer to the corresponding information on PWS/NOL.

Before you can use the auto-tune feature, the GPIB driver from the GPIB card vendor must be installed and
running.

The autotune .ini file must be in a correct place: C:\Program Files\Nokia\Phoenix\products\xx-x*
\autotune_xx-x*.ini (*= indicates the type designator of the phone, e.g. RM-1)

Context
RF autotuning is performed with the aid of Digital Radio Communication Tester. Autotuning covers all RF
tunings that are needed to perform after RF component repairs.

Note: Do not perform RF autotuning without a proper reason. Phones are tuned in production and
an RF tuning may be performed only after component repairs or if the RF tuning information is lost.

Steps
1. Connect the communication tester to the GPIB bus.

RM-88
RF Troubleshooting and Manual Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 7 –17
Copyright © 2006 Nokia. All rights reserved.



2. Start Phoenix service software.

3. From the Tools menu, choose Options -> GPIB Card.

4. In the Card Type line, select CEC8Bit, then click Start.

After clicking Start, the name of the communication tester appears in the list of found Listeners.

5. To specify the cable loss from module jig to the communication tester, choose "Set Loss" from the Tuning
menu.

6. Click the Cable tab and add the extra cable attenuation.

Note: Cable losses have to be determined on the basis of a cable used.
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7. To start autotuning, choose Auto-Tune from the Tuning menu.

8. In the Auto-Tune window, click Options.

9. In the Auto-Tune options window, see that the "Enable showing of messages" check box is checked,
then click OK.

10. To complete the RF autotuning, click OK.

Results
"Autotuning completed successfully" message appears.
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System mode independent manual tunings

Rf channel filter calibration

Context
Rf channel filter calibration tunes the internal low pass filters of Rx and Tx ASICs that limit the bandwidth of
BB IQ signals.

One common calibration is made for GSM.

Table 12 Rf channel filter calibration tuning limits

Min Typ Max

Tx filter 0 10 31

Rx filter 0 16 31

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→Rf Channel Filter Calibration .

3. Click Tune.

4. To save the values to the PMM (Phone Permanent Memory) area, click Write.

5. To close the Rf Channel Filter Calibration window, click Close.

Results

Figure 51 Rf channel filter calibration typical values
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PA (power amplifier) detection

Context
The PA detection procedure detects which PA manufacturer is used for phone PAs.

If a PA is changed or if the permanent memory (PMM) data is corrupted, PA detection has to be performed
before Tx tunings.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→PA Detection .

3. Click Tune.

4. Check that the detected PA manufacturers are corresponding to the actual chips on the board.

5. To end the procedure, click Close.

GSM receiver tunings

Rx calibration (GSM)

Context
Rx Calibration is used to find out the real gain values of the GSM Rx AGC system and tuning response of the
AFC system (AFC D/A init value and AFC slope)

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Rx Calibration .

5. Check the Load from Phone check box, and uncheck Save to Phone.

6. From the Band drop-down menu, choose e.g. GSM900.
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7. Click Start.
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8. Click Calibrate.

9. Connect the signal generator to the phone, and set frequency and amplitude as instructed in the
Rx Calibration with band EGSM900 pop-up window.

Important: The calibration uses a non-modulated CW signal. Increase the signal generator level by
cable attenuation and module jig probe attenuation.
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10. To perform the tuning, click OK.

11. Check that the tuning values are within the limits specified in the following table:

Table 13 RF tuning limits in Rx calibration

Min Typ Max Unit

GSM850

AFC Value -200 -105...62 200

AFC slope 0 122 200

RSSI0 106 107...110 114 dB

GSM900

AFC Value -200 -105...62 200

AFC slope 0 122 200

RSSI0 106 107...110 114 dB

GSM1800

RSSI0 104 104...109 114 dB

GSM1900

RSSI0 104 104...109 114 dB
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12. To save values to the phone, check the Save to Phone check box, and click Stop.

Next actions
Repeat steps 3 to 8 for GSM850, GSM1800 and GSM1900

Rx band filter response compensation (GSM)

Prerequisites
Rx calibration must be done before the Rx Band Filter Response Compensation

Context
In each GSM Rx band, there’s a band rejecting filter in front of RF ASIC front end. The amplitude ripple caused
by these filters causes ripple to the RSSI measurement and therefore calibration is needed.

The calibration has to be repeated for each GSM band.

Steps
1. Connect module jig’s GSM connector to signal generator.

2. From the dropdown menus, set "Operating mode" to Local, "System mode" to GSM, and Band to GSM900.
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3. From the Tuning menu, choose GSM -> Rx Band Filter Response Compensation.

4. Check “Manual” and “Load from Phone” check boxes. Clear “Save to Phone” check box

5. Click Start.
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6. Click Tune.

7. Connect signal generator to the phone and set frequency and amplitude as instructed in the "Rx Band
Filter Response Compensation for EGSM900" popup window.

8. To perform tuning, click OK.

9. Go through all 9 frequencies.
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10. Check that the tuning values are within the limits specified in this table:

Min Typ Max Unit

GSM850

Ch. 118 /
867.26771 MHz

-10 -1 5 dB

Ch. 128 /
869.26771 MHz

-3 0 5 dB

Ch. 140 /
871.66771 MHz

-3 0 5 dB

Ch. 172 /
878.06771 MHz

-3 0 5 dB

Ch. 190 /
881.66771 MHz

-3 0 5 dB

Ch. 217 /
887.06771 MHz

-3 0 5 dB

Ch. 241 /
891.86771 MHz

-3 0 5 dB

Ch. 251 /
893.86771 MHz

-3 0 5 dB

Ch. 261/
895.86771 MHz

-10 -1 5 dB

GSM900

Ch. 965 /
923.26771 MHz

-10 -1 5 dB

Ch. 975 /
925.26771 MHz

-3 0 5 dB

Ch. 987 /
927.66771 MHz

-3 0 5 dB

Ch. 1009 /
932.06771 MHz

-3 0 5 dB

Ch. 37 /
942.46771 MHz

-3 0 5 dB

Ch. 90 /
953.06771 MHz

-3 0 5 dB

Ch. 114 /
957.86771 MHz

-3 0 5 dB

Ch. 124 /
959.86771 MHz

-3 0 5 dB

Ch. 136 /
962.26771 MHz

-10 -1 5 dB

GSM1800
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Min Typ Max Unit

Ch. 497 /
1802.26771 MHz

-10 -1 5 dB

Ch. 512 /
1805.26771 MHz

-3 0 5 dB

Ch. 535 /
1809.86771 MHz

-3 0 5 dB

Ch. 606 /
1824.06771 MHz

-3 0 5 dB

Ch. 700 /
1842.86771 MHz

-3 0 5 dB

Ch. 791 /
1861.06771 MHz

-3 0 5 dB

Ch. 870 /
1876.86771 MHz

-3 0 5 dB

Ch. 885 /
1879.86771 MHz

-3 0 5 dB

Ch. 908 /
1884.46771 MHz

-10 -1 5 dB

GSM1900

Ch. 496 /
1927.06771 MHz

-10 -1 5 dB

Ch. 512 /
1930.26771 MHz

-3 0 5 dB

Ch. 537 /
1935.26771 MHz

-3 0 5 dB

Ch. 586 /
1945.06771 MHz

-3 0 5 dB

Ch. 661 /
1960.06771 MHz

-3 0 5 dB

Ch. 736 /
1975.06771 MHz

-3 0 5 dB

Ch. 794 /
1986.66771 MHz

-3 0 5 dB

Ch. 810 /
1989.86771 MHz

-3 0 5 dB

Ch. 835 /
1994.86771 MHz

-10 -1 5 dB

RM-88
RF Troubleshooting and Manual Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 7 –29
Copyright © 2006 Nokia. All rights reserved.



11. Check the "Save to Phone" check box and click Stop if the values are within the limits.

Next actions
Repeat the steps 4 to 10 for GSM850, GSM1800 and GSM1900.

GSM transmitter tunings

Tx IQ tuning (GSM)

Context
The Tx path branches to I and Q signals at RF I/Q modulator. Modulator and analog hardware located after
it cause unequal amplitude and phase disturbance to I and Q signal paths. Tx IQ tuning tuning balances the
I and Q branches.

Tx IQ tuning must be performed on all GSM bands. .

Steps
1. From the dropdown menus, set "Operating mode" to Local, "System mode" to GSM, and Band to GSM900.

2. From the Tuning menu, choose GSM -> Tx IQ Tuning.

3. Set Mode to Automatic and Edge to Off.

4. Click Start.

Wait until automatic tuning has finished and moved the sliders.

Values are written to the phone memory automatically.
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5. When the values have been written to the phone memory, click the Finish button to end the tuning.

6. Change band to GSM850 and repeat steps 4 to 5.

7. Change band to GSM1800 and repeat steps 4 to 5.

8. Change band to GSM1900 and repeat steps 4 to 5.

9. To close the tuning window, click Close.

Next actions
Tuning sliders should be close to the center of the scale after the tuning and within the limits specified in
the table below. If they are not within the limits, check Tx IQ quality manually.

Min Typ Max Unit

GSM850

I DC offset / Q DC
offset

-6 -4 6 %

Ampl -1 0 1 dB

Phase 85 90 95 ○

GSM900
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Min Typ Max Unit

I DC offset / Q DC
offset

-6 -4 6 %

Ampl -1 0 1 dB

Phase 85 90 95 ○

GSM1800/GSM1900

I/Q DC -6 0.5 6 %

Ampl -1 0 1 dB

Phase 95 100 110 ○

Tx power level tuning (GSM)

Context
Because of variations at IC process and discrete component values, actual transmitter RF gain of each phone
is different. Tx power level tuning is used to find out mapping factors called 'power coefficients’. These adjust
the GSM transmitter output power to fulfill the specifications.

For EDGE transmission the bias settings of the FEM are adjusted in order to improve linearity. This affects the
PA gain and hence the power levels have to be aligned separately for EDGE transmission.

Tx power level tuning has to be performed on all GSM bands.

Steps
1. Connect the phone to a spectrum analyzer.

2. From the dropdown menus, set "Operating mode" to Local, "System mode" to GSM, and Band to GSM900.

3. From the Tuning menu, choose GSM -> Tx Power Level Tuning.

4. Set Mode to Automatic and Edge to Off.

5. Set the spectrum analyzer for power level tuning:

Frequency channel frequency (836.6MHz GSM850, 897.4MHz
GSM900, 1747.8MHz GSM1800, 1880MHz
GSM1900)

Span 0 Hz

Sweep time 2ms

Trigger Video triggering (-10dBm)

Resolution BW 3MHz

Video BW 3MHz
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Reference level offset sum cable attenuation with module jig
attenuation

Reference level 33dBm

A power meter with a peak power detector can be also used. Remember to take the attenuations in the
account!

6. Click Start.

7. Adjust power levels 5, 15 and 19 to correspond the "Target dBm" column by pressing + or – keys.
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8. Click Calculate Coefficients.

9. Check that the coeffiecient values are within the limits specified in the following table.

Min Typ Max

GSM850 EDGE off

PL5 coefficient 0.45 0.626 0.73

PL15 coefficient 0.234

PL19 coefficient 0.12 0.195 0.3

GSM850 EDGE on

PL8 coefficient 0.35 0.419 0.6

PL15 coefficient 0.247

PL19 coefficient 0.12 0.204 0.3

GSM900 EDGE off

PL5 coefficient 0.45 0.626 0.73

PL15 coefficient 0.234

PL19 coefficient 0.12 0.195 0.3

GSM900 EDGE on

PL8 coefficient 0.35 0.419 0.6

PL15 coefficient 0.247

PL19 coefficient 0.12 0.204 0.3

GSM1800 EDGE off

PL0 coefficient 0.45 0.51 0.7
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Min Typ Max

PL11 coefficient 0.219

PL15 coefficient 0.12 0.185 0.3

GSM1800 EDGE on

PL2 coefficient 0.35 0.394 0.6

PL11 coefficient 0.23

PL15 coefficient 0.12 0.194 0.3

GSM1900 EDGE off

PL0 coefficient 0.45 0.482 0.7

PL11 coefficient 0.218

PL15 coefficient 0.12 0.184 0.3

GSM1900 EDGE on

PL2 coefficient 0.35 0.377 0.6

PL11 coefficient 0.23

PL15 coefficient 0.12 0.193 0.3

If the values are within the limits, check that the "Save to Phone Permanent Memory" check box is
checked and click Stop.
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10. Set Edge mode on and start tuning again. Change video averaging to 50.

11. Tune EDGE power levels to the corresponding target power levels.

Only power levels 8, 15 and 19 are tuned in GSM900 and 2, 10 and 15 in GSM1800/1900. The rest are
calculated by clicking the Calculate Coefficients button. Check the coefficients against the RF tuning limits
table presented in Step 9.

12. When the tuning is completed, click Stop.

Next actions
Repeat steps 4 to 9 for GSM1800 and GSM1900. On those bands only power levels 0, 11 and 15 need to be
tuned.
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 Baseband description

System module block diagram
The device is a quad-band GSM mono-block product with full QWERTY keyboard. It is based on Series 60 UI
Style on the Symbian Operating System (SOS) release (version 9.1).

The device has two antennas; Internal antenna for cellular quad band GSM and BT antenna.

Bluetooth module has its own antenna. System calculations assume 15dB antenna isolation between
Bluetooth and cellular GSM antenna.

Architecture overview
The device is a monoblock quadband GSM/EDGE 850/900/1800/1900 handportable phone running on
Symbian series 60 release 3.0.

Product segment is a Smart phone.

The device baseband is single processor architecture based on CeMEnt G3.1S engine (CeBBo1GSM BB + Ritsa
4.5 RF).

The baseband includes following HW-blocks:

• RAP, GSM EDGE BaseBand ASIC (ARM926EJ-S MCU, Lead3 PH3 DSP)

• N2200 , primary Energy Management ASIC

• N2300, secondary Energy Management ASIC

• T-combo memory, 256Mbit NOR FLASH + 256Mbit DDR-SDRAM + 1Gbit Mux-one Nand combo memory

• Audio (Microphone, Speaker, IHF and external audio)

• EL keyboard backlightning

• Ambient light sensor

• Bottom Connectors (Mini USB-B + 2.5mm Headset Jack + Dynamo DC jack)

• SIM Interface

• BB-RF Interface

• Bluetooth BTPerf 2.3 (BT 2.0 + EDR)

• UI (Oxford QVGA LCD, QWERTY keyboard)

• IR Interface (IrDA, 115.2kbit/s)

• Mini SD Interface (hot swappable)

RF block includes:

• N7505 AHNE RF ASIC (Quad-band GSM functionality based on Ritsa 4.5 engine.)

• N7520 front end module (PA and antenna switch)

• G7500 VCO and G7501 VCXO (38.4MHz)
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Figure 52 System level block diagram

Baseband functional description
Digital baseband is single processor architecture. It consists of RAP, EM ASIC (N2200), EM ASIC (N2300) and
memories as the core. RAP is a GSM EDGE chip with lots of peripheral features. Supported cellular protocols
in RAP are GSM (minimum EDGE class 10, GPRS phase2). In general RAP consists of three separate parts. The
first part is processor subsystem (PSS) that includes both MCU and DSP processors and related functions. The
second part is MCU peripherals that are peripherals mainly controlled by MCU. The third one is DSP peripherals
that are peripherals mainly controlled by DSP. N2200 is an audio ASIC including also energy management
(EM) functions. With second EM ASIC N2300, it covers the analog audio and energy management function.
N2200 is also the device that handles the power-up and power-down routines of the system. During the
times when the digital BB is alive N2200 handles a variety of tasks that can not be accomplished elsewhere
due to voltage requirements, noise etc. N2300 power IC is intended for energy management control, supply
voltage generation and charge control of mobile phone. N2300 has a step down type (buck) programmable
switch mode regulator for digital core supply generation, up (boost) switch mode regulator with current
control for led supply, charge control circuitry with integrated switch, level shifters and regulator for FBUS/
USB-OTG, and digital circuitry including registers. Stacked triple combo memory (RAM, Nor, Nand in one
package) includes 256Mbit DDR SDRAM , 256Mbit NOR Flash and 1Gbit Mux-One Nand.

Absolute maximum ratings

Signal Min Nom Max Uni
t Notes

Battery voltage (idle) -0.3 5.2 V Battery voltage maximum value is
specified during charging is active
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Signal Min Nom Max Uni
t Notes

Battery voltage (Call) +3.2 +4.8 V Battery voltage maximum value is
specified during charging is active

Charger input voltage -0.3 +16 V

Phone modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
N2200 master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over N2200 master
reset threshold. All regulators are disabled, PurX is on low state, the RTC is on and the
oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm), but the
RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. In this mode certain regulators are
enabled and after they and RFClk have stabilized, the system reset (PurX) is released
and PWR_ON mode entered. RESET mode uses 32 kHz clock to count the REST mode
delay (typically 16 ms).

DEEP SLEEP Deep sleep mode is entered only from Pwr_on mode with the aid of sw when the
system's activity is low. At deep sleep, VCTCXO is powering off. System is running with
the sleep clock. Regulators are in sleep mode.

FLASHING FLASHING mode is for SW downloading.

Voltage limits

Parameter Description Value

VMSTR

Master reset
threshold
(N2200) 2.2V (typ.)

VMSTR+

Master reset
threshold
level, rising
(N2300) 2.1V (typ.)

VMSTR-

Master reset
threshold
level, falling
(N2300) 1.9V (typ.)

VCOFF+

Hardware
cutoff
(rising) 2.9V (typ.)
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Parameter Description Value

VCOFF-

Hardware
cutoff
(falling) 2.6V (typ.)

SWCOFF
SW cutoff
limit ~3.2V

The master reset threshold controls the internal reset of N2200 / (N2300). If battery voltage is above VMSTR,
N2300’s charging control logic is alive. Also, RTC is active and supplied from the main battery. Above VMSTR,
N2300 allows the system to be powered on although this may not succeed due to voltage drops during start
up. SW can also consider battery voltage too low for operation and power down the system.

Power key
The system boots up when power key is pressed (adequate battery voltage, VBAT, present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW).

Operation modes
There are four different power up possibilities to switch power on:

• Power key is pressed

• Charger is connected

• A pulse is supplied to MBUS line (Clk)

• Internal power up with Real Time Clock alarm.

Power is not switched on by supplying battery voltage as in DCT4 generations

It should be noted that system behavior depends on the type of device the engine is in. The difference is
mainly in the power key concept, basically:

• The power key controls the system power ON/OFF

• The system boots up always when not empty battery is connected. The power key controls only the CMT
functionality. PDA functions are always available

• To the EM ASIC's functionality there is no difference how the power key is connected (the power up and
down signaling and timings are the same)
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Power distribution

Figure 53 Power distribution diagram

System power-up
Power up procedure starts when the user presses power key (option 1) or when (not empty) battery is
attached (option 2). In addition, some other triggers may start the system.
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Power down procedure
Controlled powering off is done with the aid of SW when the user requests it or when the battery voltage is
falling too low. Uncontrolled powering off happens for example when battery is suddenly removed.

Clocking scheme
The main system clock is a small signal sine wave created in the RF-section of the engine with Voltage
Controlled, Temperature Compensated, crystal oscillator (VCTCXO). The delivered frequency is 38.4MHz . RAP
has its own sleep mode in which use low accuracy, low frequency sleep clock instead of RF clock. In deep
sleep, ASIC is sleep mode and therefore VCTCXO can be switched off (VCTCXO is a significant power consumer).
In deep sleep also the core voltage is decreased.

Bluetooth
The device uses BTH Perf2.3 solution. The Bluetooth is V 2.0 + EDR. The Bluetooth module is implemented by
using CSR’s BC4-ROM. BlueCore-4 ROM is a single chip radio and baseband IC for Bluetooth 2.4 GHz systems.

In BB5.0 ,BT interface has been designed so that it allows attaching BT modules from different vendors. The
interface consists of UART interface and PCM interface for audio.
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Figure 54 BT-RAP connection

IrDA
IrDA specifies a reliable, fully digital peer-to-peer data link between IrDA units at data rates from 9600 bits/
s to 115 kbit/s. The link is based on the serial transmission of data as pulses of infra red light at the wave
length of 870nm and angles of +-15degrees at the range 0 - 50 to 100 cm. The transmission is not
omnidirectional but focused and only reaches a peer at a limited line-of-sight distance from the transmitter
thus not disturbing any other units in the neighbourhood.

IR communication is half-duplex e.g. the IR receiver sees its own transmission, and the IR interface is either
transmitting or receiving, but not both at once.

USB
USB (Universal Serial Bus) provides a wired connectivity between a USB host PC and peripheral devices.

USB is a differential serial bus for USB devices. USB controller supports USB specification revision 2.0 with full
speed USB (12 Mbps). The device is connected to the USB host through the system connector. The USB bus is
hot plugged capable, which means that USB devices may be plugged in/out at any time.

SIM card
The device SIM interface supports both1.8V and 3V technology smart cards.

The power is not allowed to be supplied to cards until the power contacts to battery are properly connected.

RF-BB interface
In BB-RF interface there are 19 signal pins between RAP and cellular RF.
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Between EM (N2200) and cellular RF there are 8 pins + VBAT. RF is controlled directly by RAP and N2200. Digital
control signals, such as RFBus and reset signals, are taken from RAP and analog control signals, such as AFC
and TxC, are taken from EM ASIC (N2200).

RFBUS is similar control bus than CBUS and DBUS, but it is only used as controlling interface between RF and
BaseBand (RAP). RAP controls AFC and TxC signals via TxCData bus and RF regulator control is done via CBUS.

Analog Rx and Tx signals are connected to/from RAP that includes RF converters for this purpose. The TxC
serial bus interface is a one-way bus, which is used to transfer data from RAP3G to the N2200 ASIC TXC DACs.

These DACs are used to control the RF power amplifiers. The TXC bus includes TxCCtrl pin, which is used to
select the EM ASIC (N2200) DAC, the data is written to. In case the TxCCtrl is in low state, the data is written
to the DAC1 and in case the TxCCtrl is in high state, the data is written to DAC2.

The TxC bus clock frequency is programmable but the frequency to be used in CeBBo1 is 19.2 MHz and for
RFBUS the frequency used is 9.6 MHz.

FBUS
USB and FBUS have multiplexed interface between EM ASIC (2300) and RAP.

ACI interface
The ACI (Accessory Control Interface) is a point-to-point, bi-directional, single line serial bus.

It has two main features: the insertion and removal detection of an accessory device and acting as a data
bus between phone and accessory, intended for control purposes. A third function of ACI is to identify and
authenticate the accessory.
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SIM interface
The device has one SIM (Subscriber Identification Module) interface. It is only accessible if battery is removed.
The SIM interface consists of an internal interface between RAP and EM ASIC (N2200), and of an external
interface between N2200 and SIM contacts.

The EM ASIC SIM1 interface supports both 1.8 V and 3.0 V SIM cards. The SIM interface voltage is first 1.8 V
when the SIM card is inserted, and if the card does not response to the ATR a 3 V interface voltage is used.

MiniSD interface
In the RAP the MMC/SD interface is multiplexed with NAND Flash and SIM2 interfaces.
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Figure 55 MiniSD contact area & pin order

Battery interface
The battery interface supports a 3-pole battery interface. The interface consists of three connectors: VBAT,
BSI and GND.

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.
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Figure 56 Battery pin order

Table 14 Battery interface connections

Pin Signal I/O Engine connection Notes

1 VBAT -> EM ASIC N2200 VBAT Battery voltage

2 BSI -> EM ASIC N2200 BSI Battery size
indication
(fixed resistor
inside the
battery pack)

3 GND GND Ground

Battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line, which
is located on the transceiver PWB.

For service purposes, the device SW can be forced into local mode by using pull down resistors connected to
the BSI line.

User interface

Display interface
The device supports Oxford QVGA 2.8” TFT display with 320 x 240 resolution and 24bit colors. It uses 8-bit
display interface.

Keyboard
The device uses external COP8 micro controller to handle engine & qwerty keyboard matrix. The
communication between COP8 and RAP is handled by I2C bus.

Display and keyboard backlight
The device has one LED Driver (SMPS) that is used to drive six display LEDs.

Display LEDs are connected in to two three LED series. Current adjustment of the driver is done from the
display LED branch, and keyboard current also depends on the display brightness. In a typical use case,
keyboard LEDs are turned ON only in dark ambient lighting conditions.

The keyboard backlight is made with electroluminance. The device has discrete EL-driver, which provide
backlight for keyboard.

ALS interface
Ambient Light Sensor (ALS) is located in the upper part of the phone. It consists of the following components:

• lightguide (part of the front cover)

• phototransistor (V4400) + resistor (R4401)

• NTC + resistors (R4400, R4402, R4403)
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• EM ASIC (N2200)

Information on ambient lighting is used to control the backlights of the phone:

• Keypad lighting is switched on only when the environment is dark / dim

• Display backlights are dimmed, when the environment is dark / dim

The ambient light sensor itself is a photo transistor, which is temperature-compensated by an external NTC
resistor. N2200 reads the light sensor (LS) and temperature (LST) results.

ALS calibration is not possible in the service points. ALS is serviced by replacing faulty phototransistors.

Figure 57 ALS HW implementation

Table 15 ALS resistor values

Symbol R1 R2 R3 R4 R5 R6 R7 NTC-res

Value 5 kOhm
15

kOhm
30

kOhm
50

kOhm
470

kOhm
100

kohm
470

kohm
47

kOhm

E-Mail LED
The device has E-Mail indicator LED.
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Figure 58 E-mail LED implementation

 Audio concept

Audio HW architecture
In BB5.0, the digital functions of audio are integrated into RAP and analogue functions into EM ASIC N2200.

Audio codec supports 48 kHz and 44.1 kHz sampling rates in addition to 40 kHz, which provides full 20 kHz
audio bandwidth (near CD quality) in Rx path.
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Figure 59 Audio block diagram

Internal microphone
Internal microphone is used for HandPortable (HP) and Internal HandsFree (IHF) call modes.

An analogue electret microphone is connected to Retu ASIC’s Mic1P and Mic1N is connected ground near Retu.

Figure 60 Internal microphone passive circuitry
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Internal earpiece
The internal earpiece is used in the HandPortable (HP) call mode. A dynamic 7x11 mm earpiece capsule is
connected to N2200 ASIC’s differential outputs EarP and EarN.

Figure 61 Internal earpiece circuitry

Internal speaker
The internal speaker is used in Internal HandsFree (IHF) call mode.

A dynamic 20 mm speaker is connected to N2200 ASIC’s outputs HFSpP and HFSpN.

The IHF amplifier integrated in EM ASIC N2200 is a Digital Pulse Modulated Amplifier (DPMA).

Figure 62 Internal speaker circuitry

Vibra circuitry
Vibra is used for vibra-alarm function.

The vibra motor is connected to the N2200 ASIC VibraP and VibraN Pulse Width Modulated (PWM) outputs.
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Figure 63 Vibra circuitry

 Baseband technical specifications

External interfaces

Name of Connection Connector reference

USB X2001

Charger X2000

Headset X2002

SIM X2700

MiniSD X5200

Battery connector X2070

USB IF electrical characteristics

Description Parameter Min Max Unit Notes

Absolute
maximum
voltage on D+
and D-

VD+/D- -1 4.6 V USB
specification
revision 2.0

Supply voltage VBUS 4.4 5.25 V

Supply current:

Functioning IVBUS 100 mA

Suspended IVBUS 500 uA

Unconfigured IVBUS 100 mA

High-level
input voltage:

V

High (driven) VIH 2

High (floating) VIHZ 2.7 3.6

Low-level
input voltage

VIL 0.8 V
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Description Parameter Min Max Unit Notes

Differential
input
sensitivity

VDI 0.2 V |(D+) - (D-)|

Differential
input voltage
range

VCM 0.8 2.5 V Included VDI
range

Low-level
output voltage

VOL 0 0.3 V

High-level
output voltage
(driven)

VOH 2.8 3.6 V

Output signal
crossover
voltage

VCRS 1.3 2 V

FBUS interface electrical characteristics (between RAP and N2300)

Description Parameter Min Max Unit

High-level input voltage VIH 0.7 x
VDDSHV2

VDDSHV2 V

Low-level Input voltage VIL 0 0.3 x
VDDSHV2

V

High-level output voltage VOH 0.8 x
VDDSHV2

VDDSHV2 V

Low-level output voltage VOL 0 0.22 x
VDDSHV2

V

Rise/fall time tR/tF 0 25 ns

(VDDSHV2 = 1.8V)

SIM IF connections

Pin Signal I/O Engine connection Notes

C1 VSIM Out N2200 VSIM1 Supply voltage
to SIM card, 1.8
V or 3.0 V.

C2 SIMRST Out N2200 SIM1Rst Reset signal to
SIM card

C3 SIMCLK Out N2200 SIM1ClkC Clock signal to
SIM card

C5 GND - GND Ground

C7 SIMDATA In/Out N2200 SIM1DaC Data input /
output
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MiniSD interface connections

Signal
name/
RAP3G

Signal
name/ SD

Card

Signal Properties

Direction -- Levels -- Freq./Timing
Resolution

Descriptio
n / Notes

GenIO 09
or

MMCCmd <> 0-1.8 V /
0-3.6V

SD
Comman
dGenIO 54

GenIO 13
or GenIO
53

MMCClk > 0-1.8 V /
0-3.6V

Max 25
MHz

SD Clock

GenIO 08
or

MMCDa <> 0-1.8 V /
0-3.6V

SD Data
bit 0

GenIO 55

GenIO 07 MMCLSSh
utDn

> 0-1.8 V /
0-3.6V

Level
shifter
shutdow
n

GenIO 10 SDDa2 < 0-1.8 V /
0-3.6V

Data bit 1

> 

GenIO 14 SDDa3 < 0-1.8 V /
0-3.6V

Data bit 2

> 

GenIO 15 SDDa4 < 0-1.8 V /
0-3.6V

Data bit 3

> 

GenIO 12
or GenIO
65

MMCCmd
Dir

> 0-1.8 V /
0-3.6V

Comman
d Dir

GenIO 11
or GenIO
66

MMCDaDir > 0-1.8 V /
0-3.6V

Data bit 0
Dir

GenIO 03 SDDaDir2 > 0-1.8 V /
0-3.6V

Data bit 1
Dir

GenIO 04 SDDaDir3 > 0-1.8 V /
0-3.6V

Data bit 2
Dir

GenIO 05 SDDaDir4 > 0-1.8 V /
0-3.6V

Data bit 3
Dir

GenIO 46 MMCDet < 0-1.8 V /
0-3.6V

Card
insert/
removal
detection
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Signal
name/
RAP3G

Signal
name/ SD

Card

Signal Properties

Direction -- Levels -- Freq./Timing
Resolution

Descriptio
n / Notes

GenIO 06 SD Write
Protect

< 0-1.8 V /
0-3.6V

Write
protect
detection
, used
only with
normal
size SD
Card

GenIO 02 MMCFBClk < 0-1.8 V /
0-3.6V

Clock
Feedback

Charger connector and charging interface connections & electrical characteristics

Figure 64 Charger connector

Table 16 Charging interface connections

Pin Signal I/O Engine connection Notes

1 Vchar In N2300 VCharIn1, 2 Charging
voltage /
charger
detection,
Center pin

2 Charge GND Ground Charger
ground

Table 17 Charging IF electrical characteristics

Description Parameter Min Max Unit Notes

Vchar V Charge 0 9 V Center pin

Vchar I Charge 0.85 A Center pin

Charge GND 0.85 A
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Description Parameter Min Max Unit Notes

Threshold for
charging,
rising (N2300)

VMSTR+ 2.1 V Typical value

Threshold for
charging,
falling (N2300)

VMSTR- 1.9 V Typical value

Battery interface electrical characteristics

Table 18 Battery IF electrical characteristics

Description Parameter Max Unit

Operation voltage VIN 4.23 VDC

Current rating IIN 0.9 A

Internal interfaces

Name of Connection Connector reference

Joystick connector X4500

Display X4400

ALS V4400

Vibra M2100

Microphone B2100

Earpiece B2101

IHF speaker B2102

l2C
I2C is an Inter IC bus and aimed for slow control of peripherals.

The device uses I2C to interconnect QWERTY keyboard controller to RAP.

Keyboard interface electrical characteristics

Description Parameter Min Typ Max Unit Notes

High-level
input voltage

VIH 0.65* VDDS VDDS 0.3+ VDDS V Row

Low-level
input voltage

VIL -0.3 0 0.35* VDDS V Row

High-level
output
voltage

VOH 1.62 VDDS 1.98 V Column

Low-level
output
voltage

VOL 0 0.45 V Column
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Description Parameter Min Typ Max Unit Notes

(VDDS = 1.8V)

Display connector and interface connections

Pin Signal I/O Engine connection Notes

1 V LED1 + <- N2301 VLEDout N2301 is
controlled by

EM ASIC
(N2300)

2 V LED2 + <- N2301 VLEDout N2301 is
controlled by

EM ASIC
(N2300)

3 VDD <- EM ASIC
(N2200)

VAUX Core Voltage

4 GND

5 RDX <- RAP Lcdrdx Read Enable
(active low)

6 D/CX <- RAP Lcdrmd Data/
Command

select

(high = data

low =
command)

7 D1 <-> RAP Lcdda1 Data

8 D3 <-> RAP Lcdda3 Data

9 GND
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Pin Signal I/O Engine connection Notes

10 D5 <-> RAP Lcdda5 Data

11 D7 <-> RAP Lcdda7 Data

12 TE -> RAP Te Tearing Effect

13 RESX <- RAP Gpio60 Reset (active
low)

14 CSX <- RAP Lcdsx Chip Select
(active low)

15 D6 <-> RAP Lcdda6 Data

16 D4 <-> RAP Lcdda4 Data

17 D2 <-> RAP Lcdda2 Data

18 GND

19 D0 <-> RAP Lcdda0 Data

20 WRX -> RAP Lcdwrx Write Enable
(active low)

21 GND

22 VDDI <- EM ASIC
(N2200)

VIO Interface
voltage

23 V LED2 - -> R2303 SETCURR1 Resistor

24 V LED1 - -> R2303 SETCURR1 Resistor

Back-up battery interface electrical characteristics

Table 19 Back-up battery connections

Pin name I/O Connection Notes

L2207,
VBack

-> N2200,
VBack

Back-up battery G2200 is
connected to N2200 via coil

Table 20 Back-up battery electrical characteristics

Description Parameter Min Typ Max Unit

Back-Up
Battery
Voltage

Vback 0 2.5 2.7 V
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 Frequency mappings

GSM850 frequencies
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EGSM900 frequencies
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GSM1800 frequencies
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GSM1900 frequencies
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RM-88
Schematics Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –5
Copyright © 2006 Nokia. All rights reserved.



 TAHVO
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 Bluetooth
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 UI part 1
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 UI part 2
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 RF part
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 Audio, IHF, Vibra

RM-88
Schematics Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –12
Copyright © 2006 Nokia. All rights reserved.



 SIM interface
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 IrDA interface

RM-88
Schematics Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –14
Copyright © 2006 Nokia. All rights reserved.



 MMC interface
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 CMT memories
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A/D-converter Analog-to-digital converter

ACI Accessory Control Interface

ADC Analog-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic ,type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2,UEME and Zocus

CCP Compact Camera Port

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSR cambridge silicon radio

CSTN Color Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analouge converter

DAC Digital-to-analouge converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package
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DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evaluation

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compability

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

IrDA Infrared Data Associasion

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode
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LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architechture

OMAP Operations, maintenance, and administartion part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RF PopPort TM Reduced function PopPortTM interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multi Media Card

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver
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SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noice ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP, Official Tiku3G

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WD Watchdog

XHTML Extensible hypertext markup language

Zocus Current sensor, (used to monitor the current flow to and from the battery)
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